**Introduction**

This Handbook explains the basic operations and useful features of your CLIÉ™ handheld.

---

**Using your CLIÉ handheld for the first time**

The basic features and operations are explained in detail (pages 9-71).

- **CLIÉ™ handheld basic operations**
  Explains the basic operations of your CLIÉ handheld and how to use the applications.

- **Entering text on your CLIÉ™ handheld**
  Explains how to enter text on your CLIÉ handheld.

- **Exchanging and updating files/data using the HotSync® operation**
  Explains how to use your CLIÉ handheld with your computer.

---

**CLIÉ handheld advanced operations**

Useful and advanced features to make full use of your CLIÉ handheld are explained in detail (pages 72-195).

- **Customizing your CLIÉ™ handheld (Preferences)**
  Explains how to customize your CLIÉ handheld in a way that suits you.

- **Exchanging and updating files/data using the HotSync® operation (Other HotSync® operations)**
  Explains the various methods of HotSync® operations.

- **Using storage media such as “Memory Stick™” media**
  Explains how to use files/data stored on storage media such as “Memory Stick” media.

- **Beaming**
  Explains how to exchange data or applications with another CLIÉ handheld by beaming.

- **Using the Bluetooth™ function (for Bluetooth™ built-in models only)**
  Explains how to exchange files/data with another CLIÉ handheld using the Bluetooth™ function.

- **Using the Calculator and finding records**
  Explains how to use the calculator and how to find records.

- **Backing up your CLIÉ™ handheld data and applications**
  Explains how to back up the data and applications of your CLIÉ handheld.

- **Protecting your data with a password**
  Explains how to assign a password to restrict the use of your CLIÉ handheld or to protect your data.

- **Enhancing features with add-on applications**
  Explains how to install additional applications on your CLIÉ handheld.

- **Transferring data from another CLIÉ™ handheld**
  Explains how to transfer data from your old CLIÉ handheld to your new CLIÉ handheld.
The following manuals are included with your CLIÉ handheld. Refer to the following together with this manual.

- **Before you start using your CLIÉ handheld**

<table>
<thead>
<tr>
<th>Manual</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Read This First (Operating Instructions)</strong></td>
<td>Explains the following:</td>
</tr>
<tr>
<td></td>
<td>• Setting up your CLIÉ handheld and computer</td>
</tr>
<tr>
<td></td>
<td>• Basic operations</td>
</tr>
<tr>
<td></td>
<td>• What you can do with the applications</td>
</tr>
<tr>
<td></td>
<td>Be sure to read the supplied “Safety &amp; Regulations Guide” to use your CLIÉ handheld safely.</td>
</tr>
</tbody>
</table>

- When you want to become more familiar with the basic operations of the CLIÉ handheld
- When you want to change the settings of your CLIÉ handheld

<table>
<thead>
<tr>
<th>Handbook (This manual)</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Using your CLIÉ handheld for the first time</td>
<td>The basic features and operations are explained in detail.</td>
</tr>
<tr>
<td>CLIÉ handheld advanced operations</td>
<td>Useful and advanced features to make full use of your CLIÉ handheld are explained in detail.</td>
</tr>
</tbody>
</table>

- When you want to become more familiar with using the supplied applications
- When you want to install additional applications

| CLIÉ Application Manual (HTML format: Read via a computer screen) | Explains how to use the supplied applications in detail. For details on using the manual, refer to “Using the CLIÉ Application Manual” in the “Read This First (Operating Instructions).” |

- When you have problems

| Troubleshooting Q&A | Helps in solving common problems that you may have while using your CLIÉ handheld. |

**Notes**

- Some of the illustrations in this manual (Handbook) may not be consistent with your CLIÉ handheld.
  - For details on your CLIÉ handheld, refer to the “Read This First (Operating Instructions).”
- Some of the accessories described in this manual (Handbook) may not be supported by your CLIÉ handheld.
# Table of Contents

## CLIÉ™ handheld basic operations

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic operations</td>
<td>10</td>
</tr>
<tr>
<td>Using the stylus</td>
<td>10</td>
</tr>
<tr>
<td>Using the Jog Dial™ navigator</td>
<td>12</td>
</tr>
<tr>
<td>Starting an application</td>
<td>14</td>
</tr>
<tr>
<td>Starting an application in the Application Launcher screen</td>
<td>14</td>
</tr>
<tr>
<td>Quitting an application</td>
<td>15</td>
</tr>
<tr>
<td>Using CLIE Launcher</td>
<td>17</td>
</tr>
<tr>
<td>Locating the components</td>
<td>17</td>
</tr>
<tr>
<td>CLIE Launcher group</td>
<td>18</td>
</tr>
<tr>
<td>Using Favorite Applications (shortcuts)</td>
<td>22</td>
</tr>
<tr>
<td>Application manager icon</td>
<td>24</td>
</tr>
<tr>
<td>Displaying information about applications</td>
<td>25</td>
</tr>
<tr>
<td>Menu List</td>
<td>26</td>
</tr>
<tr>
<td>Using the Palm OS® standard screen</td>
<td>28</td>
</tr>
<tr>
<td>Switching to the Palm OS® standard screen</td>
<td>28</td>
</tr>
<tr>
<td>Starting an application</td>
<td>30</td>
</tr>
<tr>
<td>Changing the display style of the Palm OS® standard screen</td>
<td>34</td>
</tr>
<tr>
<td>Displaying applications by category</td>
<td>36</td>
</tr>
<tr>
<td>Changing fonts</td>
<td>38</td>
</tr>
<tr>
<td>Common menu items</td>
<td>39</td>
</tr>
</tbody>
</table>

Continued on next page
Entering text on your CLIÉ™ handheld

Entering text on your CLIÉ™ handheld. ............................. 42
Selecting a handwriting input system ............................... 43
Using Graffiti® writing to enter text ............................... 44
  What is Graffiti writing? ........................................... 44
  Entering text ....................................................... 51
  Using Navigation strokes and shortcuts .......................... 54
Using Decuma Input to enter text .................................. 56
  Entering text ....................................................... 56
Using the on-screen keyboard to enter text ....................... 60
  Entering text ....................................................... 60

Exchanging and updating files/data using the HotSync® operation

What is the HotSync® operation? .................................. 64
Performing the HotSync® operation ............................... 66
  Performing the HotSync® operation with the cradle
  (Local HotSync®) ................................................ 66
Using the Palm™ Desktop for CLIÉ software ................... 68
  Starting the Palm™ Desktop for CLIÉ software ............... 68
  Locating components of the Palm™ Desktop for CLIÉ software ... 69
  Basic operations of the Palm™ Desktop for CLIÉ software .... 70

Continued on next page
Customizing your CLIÉ™ handheld (Preferences)

What you can do with Preferences ............................................. 73
Setting the Bluetooth™ function (for Bluetooth™ built-in models only) .................................................. 75
  Turning the Bluetooth™ function on or off .......................... 75
  Viewing/Customizing Bluetooth™ information .................... 76
  Displaying/Deleting the information of target Bluetooth™ compatible devices ............................................. 77
Assigning applications to application buttons ....................... 78
Customizing the full-screen pen stroke activities .................... 79
Assigning applications to HotSync buttons .......................... 80
Adding/Changing communication device preferences .............. 81
Setting up the Date & Time preferences ................................. 83
  Setting the date .......................................................... 83
  Setting the time ......................................................... 84
  Setting the time zone and daylight saving time .................. 85
Adjusting the Digitizer ...................................................... 86
Setting the display format of the time, date, and numbers ........ 87
  Selecting a regional default .......................................... 87
  Customizing your own settings for each unit .................... 87
Setting the automatic power-off time .................................. 88
Setting sounds ............................................................. 89
Turning the Alarm LED on or off ........................................ 90
Turning the Beam Receive feature on or off ........................ 91
Changing the Network preferences ...................................... 92
  Selecting a service template ........................................ 92
  Entering a user name ............................................... 93
  Entering a password ............................................... 93
  Selecting a connection ............................................. 94
  Adding detailed information to a service template ............. 94
  Creating additional service templates ............................ 96
  Creating log-in scripts ............................................. 97
  Using the Network preferences menus ............................. 100
Creating Graffiti® ShortCuts .............................................. 101

Exchanging and updating files/data using the HotSync® operation (Other HotSync® operations)

Customizing HotSync® application settings (Conduit) .............. 103
Synchronizing with external data (File Link) .......................... 105
Customizing HotSync® Manager startup and HotSync® setup options .................................................. 106
Performing the IR HotSync® operation ................................. 107
Performing the HotSync® operation using the Bluetooth™ function (for Bluetooth™ built-in models only) .................. 110
Performing the HotSync® operation via a modem .................. 114
Performing the HotSync® operation via a network .................. 120
Performing the HotSync® operation via LAN (LANSync) ........ 124

Continued on next page
Using storage media such as “Memory Stick™” media

Using storage media such as “Memory Stick™” media...................... 128
The type of storage media you can use with your CLIÉ handheld........... 128
Using “Memory Stick” media.................................................. 128
Protecting the files/data on “Memory Stick” media......................... 130
Starting an application on storage media.................................... 131
Viewing information of storage media (Card Info)......................... 132
Assigning a name to storage media......................................... 133
Formatting storage media...................................................... 134
Exchanging files/data via storage media...................................... 136
Starting CLIE Files............................................................. 136
Copying your CLIÉ handheld files/data to storage media.................. 138
Copying files/data on storage media to your CLIÉ handheld............ 141
Deleting files/data on storage media........................................ 143
Extracting a Zip file............................................................. 144
CLIE Files menu items....................................................... 147
Exchanging files/data without using CLIE Files............................ 148
Notes on starting applications from storage media......................... 149

Beaming

Beaming between your CLIÉ handheld and another Palm OS® PDA........ 151
What you can do with beaming............................................... 151
Beaming information............................................................ 152

Using the Bluetooth™ function
(for Bluetooth™ built-in models only)

Exchanging files/data using the Bluetooth™ function....................... 156
What you can do with the Bluetooth™ function.......................... 156
Sending files/data, such as image files or Date Book data, to another CLIÉ handheld with the built-in Bluetooth™ function or Bluetooth™ Module (optional)............................................ 156
Performing the wireless HotSync® operation with a computer........ 158
Connecting to the Internet by communicating with a Bluetooth™ compatible mobile phone........................................... 159

Continued on next page
Using the Calculator and finding records

Using the Calculator (Calc) .................................. 166
Calculating with the Calculator 166
The functions of the Calculator buttons .................. 167
Using the Calculator menus .......................... 168
Finding records ........................................... 169
Using the Find option .................................. 169

Backing up your CLIÉ™ handheld data and applications

Backing up your CLIÉ™ handheld data and applications .......................... 172
Backing up data and applications to your computer with the HotSync® operation .......... 172
Backing up data and applications to “Memory Stick” media using Memory Stick Backup ........ 173

Protecting your data with a password

Entering personal information ................................ 177
Locking your CLIÉ handheld with a password (Data protection) ................. 179
Turning off your CLIÉ handheld after locking .................. 179
Setting your CLIÉ handheld to be locked automatically .................. 181
Protecting data .............................................. 182
Assigning a password .................................. 182
Changing or deleting a password ............................ 183
Hiding or masking private data ................................ 184

Enhancing features with add-on applications

Enhancing features with add-on applications .................. 186
Installing .................................................. 187
Installing from your computer ................................ 187
Installing applications on storage media ...................... 189
Installing from the Internet ................................ 189
Deleting installed add-on applications ...................... 190

Transferring data from another CLIÉ™ handheld

Transferring data from another CLIÉ™ handheld .................. 193
Transferring data using the Palm™ Desktop for CLIÉ software ........ 193

INDEX ................................................. 196
This chapter explains the basic operations of your CLIÉ handheld such as using the stylus and the Jog Dial™ navigator, locating components and starting applications.
The chapter also gives an overview of menus that are common to applications and explains how to select character fonts.

**Basic operations** ......................... 10
**Starting an application** .................... 14
**Using CLIE Launcher** ...................... 17
**Using the Palm OS® standard screen** ..... 28
**Changing fonts** ............................ 38
**Common menu items** ..................... 39
Basic operations

Operating using the stylus and the Jog Dial™ navigator.

Using the stylus

What is a stylus?
A stylus is a pen for operating your CLIÉ handheld by directly touching the screen.

Tip
Where is the stylus located?
The stylus is stored in your CLIÉ handheld. The exact storage location varies depending on your model. For details, refer to “CLIÉ™ handheld components” in the “Read This First (Operating Instructions).”

Note
To prevent losing the stylus, always put it back in its holder on your CLIÉ handheld after use.
You can operate your CLIÉ handheld using the stylus in the following ways.

**Tapping**
Lightly pressing the required item on the screen with the stylus is called “Tapping.” When entering text with the on-screen keyboard or starting an application, “tap” the desired button or icon with the stylus.

**Dragging**
Touching the required item on the screen with the stylus and moving it along the screen surface is called “Dragging.” Just as you “drag” the mouse on your computer, use the stylus to “drag” the scroll bar to scroll the screen, or “drag” characters to highlight them.
Basic operations

Using the Jog Dial™ navigator

What is the Jog Dial™ navigator?
Your CLIÉ handheld is equipped with a Jog Dial™ navigator, located at the left side of your CLIÉ handheld. This enables you to perform major operations one-handed without the stylus.

Rotating the Jog Dial™ navigator
Rotate the Jog Dial™ navigator to find the application you want to start.

Continued on next page
Basic operations

Pressing the Jog Dial™ navigator

Press the Jog Dial™ navigator to select an item or to start a selected application.

Note

The operations you can perform by using the Jog Dial™ navigator vary depending on the application.

For details on the operations of each application, refer to the “CLIE® Application Manual” installed on your computer.

Tip

Rotating while pressing the Jog Dial™ navigator

In some applications, operations are executed by pressing and rotating the Jog Dial™ navigator.
Software that you can use on your CLIÉ handheld to execute a task, such as **Date Book, To Do List**, or e-mail software, is called an “application.” You need to start an application to operate your CLIÉ handheld.

**Note**

For details on starting applications on “Memory Stick” media or CF compatible memory card (referred to as storage media), refer to page 131.

There may be some system limitations when starting applications on a storage media in the Application Launcher screen.

**Tip**

**What is the Application Launcher screen?**
The screen displayed when you turn on your CLIÉ handheld or tap the Home 🏡 icon, is called the Application Launcher screen. The screen specific to the CLIÉ handheld, **CLIE Launcher**, is displayed by default.

---

**Starting an application in the Application Launcher screen (CLIE Launcher)**

1. Tap the Home 🏡 icon. The CLIE Launcher screen is displayed.
2 Rotate the Jog Dial™ navigator to select an application icon and press the Jog Dial™ navigator to start the application.

Tip
You can also tap an application icon in the CLIE Launcher screen to start the application.

Quitting an application
You do not need to save data manually on the CLIÉ handheld as you do with the computer. All the changes in the application that you are working on are automatically saved, and the last screen you worked on is displayed when you restart the application. Display the CLIE Launcher screen to switch to another application while you are working on an application. You can select one of two methods to display the CLIE Launcher screen as follows.

Return to the CLIE Launcher screen by tapping the Home icon.

Return to the CLIE Launcher screen by pressing and holding the BACK button.
Starting an application

Tip
You can switch an application to another application by pressing the Application button.

Note
For some applications, you need to save data manually.
- For details, refer to the “CLIÉ Application Manual” installed on your computer.
Using CLIE Launcher

Locating the components

**Tip**
Tap the Home icon to display the CLIE Launcher screen if it is not displayed.

1. **CLIE Launcher group list (page 18)**
   Displays the list of the CLIE Launcher groups.

2. **Favorite Applications (shortcuts) (page 22)**
   You can create shortcuts to frequently used applications.

3. **Application manager icons (page 24)**
   You can manage your applications by tapping these icons. Additional functions will be added to manager icons when you install certain applications.

4. **Application icon list**
   Displays application names and icons.
CLIE Launcher group

You can organize applications by grouping them.

**Note**

Applications on storage media cannot be grouped.

**Editing groups**

1. Tap the Home  icon.  
The CLIE Launcher screen is displayed.

2. Tap the Menu  icon.  
The menu is displayed.

3. Select **Edit CLIE Launcher Group** from the CLIE Launcher menu.  
The **CLIE Launcher Group** setting screen is displayed.

   ![CLIE Launcher Group setting screen]

**Note**

CLIE Launcher groups differ from Palm OS® standard screen categories.
4 Select a group to edit and tap **Edit**.
The **CLIE Launcher Group** screen is displayed.

![CLIE Launcher Group](image)

**Name**: You can rename groups.

**Ordering applications listed**: Select an application and tap **Up** or **Down** to reposition applications in the CLIE Launcher screen.

**Adding applications**: Tap **Add** to display the list and select an application to add.

**Removing applications**: Select an application to be removed and tap **Remove**. Applications removed will be listed in the Unfiled group.

**Note**
The Unfiled group cannot be renamed.

5 Tap **Done**.
The **CLIE Launcher Group** setting screen is displayed.
6 Tap **Done**.
   The **CLIE Launcher** screen is displayed.

**Tip**
When the **Use Drag&Drop** check box on the CLIE Launcher **Preferences** screen (page 27) is on, you can add an application to a group by dragging its icon and dropping it in the group on the CLIE Launcher screen.

**Ordering listed groups**

1 Select a group on the **CLIE Launcher Group** setting screen.

2 Tap **Up** or **Down**.
   The order of listed groups in the CLIE Launcher screen is changed.

**Creating a new group**

1 Tap **New** on the **CLIE Launcher Group** setting screen.

2 Enter a new group name and then tap **OK**.

**Note**
Groups that do not include an application are not listed in the main screen.
Deleting a group

1 Select a group you want to delete and tap Delete on the CLIE Launcher Group setting screen.

If the group to be deleted includes any applications, the Delete CLIE Launcher Group dialog box will be displayed. In the dialog box, tap Yes to delete the group. The applications included in the deleted group will be listed in the Unfiled group.

**Note**
You cannot delete the Unfiled group.

Selecting a group

1 Tap the Home icon.

The CLIE Launcher screen is displayed.

2 Press the BACK button.

You can now perform operations on the CLIE Launcher Group List screen with the Jog Dial™ navigator.

3 Rotate the Jog Dial™ navigator to select a group.

The application icon at the top of the list in the group will be highlighted.

If you press the Jog Dial™ navigator, the application icon at the top of the list is selected.
Using CLIE Launcher

Tips

- Applications saved on storage media will be listed in the Card group.
- You can select the next group by tapping the Home icon. You can also tap the / icon or group names on the screen to select a group.

Using Favorite Applications (shortcuts)

You can create a Favorite Application (shortcut) to frequently used applications.

Note

You cannot create a Favorite Application (shortcut) for an application on storage media.

Creating a Favorite Application (shortcut)

1. Tap the Home icon. The CLIE Launcher screen is displayed.

2. Tap the Menu icon. The menu is displayed.

3. Select Edit Favorite Applications from the CLIE Launcher menu. The Favorite Application screen is displayed.
Tip
You can also tap the empty Favorite Application (shortcut) area on the CLIE Launcher screen to display the Favorite Application screen.

4 Tap a Favorite Application (shortcut) number that you want to assign to an application.
The list of applications is displayed. Tap the application name to create a Favorite Application (shortcut).

5 Tap Done.

Note
When you delete an application that is saved as a shortcut, the shortcut is also automatically deleted from the Favorite Application list.

Tip
When the Use Drag&Drop check box on the CLIE Launcher Preferences screen (page 27) is on, you can create a Favorite Application (shortcut) for an application by dragging its icon and dropping it in the empty shortcut area.
To delete a Favorite Application (shortcut)
In step 4, tap a Favorite Application (shortcut) number that you want to delete and select (None) at the top of the list.

Tip
When the Use Drag&Drop check box on the CLIE Launcher Preferences screen (page 27) is on, you can delete a Favorite Application (shortcut) for an application by dragging its icon and dropping it in at the top right of the screen.

Application manager icon
You can manage your applications with the application manager icons.
The following icons are featured as standard functions:

- : Transferring applications
  Displays Beam dialog box (page 151) or Send dialog box* (page 156).
- : Displaying application information (page 25)
- : Deleting applications (page 190)
  * for Bluetooth™ built-in models only

Tips
- Additional functions will be added to manager icons when you install certain applications.
- When the Use Drag&Drop check box on the CLIE Launcher Preferences screen (page 27) is on, you can manage an application by dragging its icon and dropping it in each application manager icon.
Using CLIE Launcher

Displaying information about applications

1. Tap the Home icon. The CLIE Launcher screen is displayed.

2. Tap . The list of applications is displayed.

3. Tap an application name whose information you want to display. The CLIE Launcher Info screen is displayed. Tap OK to close the screen.

   Tip
   When the Use Drag&Drop check box on the CLIE Launcher Preferences screen (page 27) is on, you can also display information about an application by dragging its icon and dropping it in at the top right of the CLIE Launcher screen.
Using CLIE Launcher

**Editing a description**

Tap **Edit** to display the **Edit Description** screen and enter the new description.

**Edit Description**

Please enter the application's description.

My schedule

[OK] [Cancel] [Default]

**OK button:** Changes to the description entered.

**Cancel button:** Cancels the description entered.

**Default button:** Restores the default description.

---

**Menu List**

The following list describes the functions of each menu in the CLIE Launcher screen.

**Menus in the CLIE Launcher screen**

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Delete…</strong></td>
<td>Deletes an application (page 190).</td>
</tr>
<tr>
<td><strong>Beam…</strong></td>
<td>Sends an application or data to another Palm OS PDA device via the IR port (page 151).</td>
</tr>
<tr>
<td><strong>Send…</strong></td>
<td>Sends an application or data to another <strong>Bluetooth</strong> compliant Palm OS PDA device by wireless communication (page 156). Sends messages via a connected <strong>SMS</strong>: GSM wireless device, such as a mobile phone.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>Applications and data cannot be sent by <strong>SMS</strong>.</td>
</tr>
<tr>
<td><strong>Edit CLIE Launcher Group</strong></td>
<td>Edits a group of applications (page 18).</td>
</tr>
<tr>
<td><strong>Edit Favorite Applications</strong></td>
<td>Creates a shortcut to an application (page 22).</td>
</tr>
</tbody>
</table>

*Continued on next page*
Using CLIE Launcher

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Info...</strong></td>
<td>Displays the version, memory size, and the number of records of an application.</td>
</tr>
<tr>
<td><strong>Copy...</strong></td>
<td>Copies an application.</td>
</tr>
</tbody>
</table>

* for Bluetooth™ built-in models only

**Options menu in the CLIE Launcher screen**

<table>
<thead>
<tr>
<th>Preference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Preferences...</strong></td>
<td>Makes settings for the CLIE Launcher screen.</td>
</tr>
<tr>
<td><strong>Show Expansion Cards</strong></td>
<td>Check the box to display the applications on the storage media. (Default: <strong>On</strong>)</td>
</tr>
<tr>
<td><strong>Display Animation</strong></td>
<td>Check the box to adjust on-screen motion such as the scrolling operation. (Default: <strong>On</strong>)</td>
</tr>
<tr>
<td><strong>Use Drag&amp;Drop</strong></td>
<td>Check the box to enable the Drag&amp;Drop function. (Default: <strong>Off</strong>)</td>
</tr>
<tr>
<td><strong>Use Beam Icon To Beam Only</strong></td>
<td>(available only when there is a communication facility other than beaming) Check the box to display the Beam screen automatically when you tap the Beam icon. (Default: <strong>Off</strong>)</td>
</tr>
<tr>
<td><strong>Display</strong></td>
<td><strong>Icon</strong>: Displays a simple description for any application.</td>
</tr>
<tr>
<td></td>
<td><strong>Icon (Small)</strong>: Displays a simple description for a selected application. (Default: <strong>Icon</strong>).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Go To Standard View</strong></th>
<th>Switches to the Palm OS standard screen (page 28).</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>About Applications</strong></td>
<td>Displays version information of the application.</td>
</tr>
</tbody>
</table>
Using the Palm OS® standard screen

Switching to the Palm OS® standard screen

Your CLIÉ handheld is initially set to display the CLIE Launcher screen when you tap the Home icon. To switch to the Palm OS standard screen, follow the procedure below.

1. Tap the Home icon.
   The CLIE Launcher screen is displayed.

2. Tap the Menu icon.
   The menu is displayed.

3. Tap **Go To Standard View** from the **Options** menu.
   The screen will be switched to the Palm OS standard screen.

   Tip
   You can display categories in sequence by tapping the Home icon.

   Note
   Palm OS standard screen categories differ from CLIE Launcher groups.
Using the Palm OS® standard screen

Switching to the CLIE Launcher screen

1 Tap the Home icon. The Palm OS® standard screen is displayed.

2 Tap the Menu icon. The menu is displayed.

3 Tap Go To CLIE Launcher View from the Options menu. The screen is switched to the CLIE Launcher screen.
Starting an application

Note
For details on starting applications on storage media, refer to page 131.
There may be some system limitations when starting applications on storage media in the Application Launcher screen.

Starting an application with the Jog Dial™ navigator

1 Tap the Home 📐 icon. The Palm OS® standard screen is displayed.

2 Rotate the Jog Dial™ navigator to select the application you want to start, and then press the Jog Dial™ navigator.
Using the Palm OS® standard screen

Changing the preferences of the start-up screen for the Jog Dial™ navigator operation

Set the preferences so that rotating the Jog Dial™ navigator displays a list of applications on the left side of the screen.

1. **Tap the Menu icon on the Palm OS® standard screen.**
   The menu is displayed.

   ![Menu Screen]

   - **App**:
     - Delete...
     - Beam...
     - Send...
     - Category...
     - Info...
     - Copy...
     - Call Info
     - CLIE Album
     - CLIE Camera
     - CLIE Files
     - CLIE Mail
     - CLIE Memo
     - CLIE RMC
     - CLIE Viewer
     - Data Import

2. **Tap Preferences from the Options menu.**
   The Preferences screen is displayed.

   ![Preferences Screen]
3 Tap the arrow ▼ next to Jog Select and select PopUp.

4 Tap OK.
When the Jog Dial™ navigator is rotated, the list of applications is automatically displayed on the left of the screen.
Using the Palm OS® standard screen

Starting an application by tapping an application icon

1 Tap the Home icon. The Palm OS® standard screen is displayed.

2 Tap the icon of the application you want to start.
Changing the display style of the Palm OS® standard screen

On the Palm OS standard screen, you can display applications in the list format or in the small-icon format. You can also choose to display your favorite category or last-used application when the Palm OS standard screen is displayed.

1 Tap the Home icon. The Palm OS® standard screen is displayed.

2 Tap the Menu icon. The menu is displayed.

3 Tap Preferences from the Options menu.

4 Tap the arrow ▼ to the right of View By and select List, List (Small) or Icon (Small).

5 Tap OK.
Setting to display the last-opened category or the last-used application when the Palm OS standard screen is displayed

1 Tap the Home icon.
The Palm OS® standard screen is displayed.

2 Tap the Menu icon.
The menu is displayed.

3 Tap Preferences from the Options menu.

4 Tap the Remember Last Category check box or Remember Last Used App check box, to select your preference.
The check boxes are marked by the default setting.

5 Tap OK.

Note
Applications are not recognized as the last-used applications and categories in the following cases:
• Pressing an application button to start an application or category.
• Switching the screen from Palm OS standard view to CLIE Launcher view.
Using the Palm OS® standard screen

Displaying applications by category

You can choose to display applications by category.

Categorizing applications

1. Tap the Home icon. The Palm OS® standard screen is displayed.

2. Tap the Menu icon. The menu is displayed.

3. Tap Category from the Application menu.

4. Tap the arrow ▼ next to each application and select the category.

   Note
   To create a new category, tap the arrow ▼ at the top right of the Application Launcher screen, and then tap Edit Categories to open the Edit Categories dialog box. Tap New, enter a category name, and tap OK. Tap OK again when the new category is added.

5. Tap Done.
Displaying applications by category

1 Tap the Home icon. The Palm OS® standard screen is displayed.

2 Perform either of the following operations.
   • Repeatedly tap the Home icon or repeatedly press the Jog Dial™ navigator to display the categories in sequence.
   • Tap the arrow at the top right of the screen and select the category you want to display.

   Tip
   If you select All, all applications are displayed on the Palm OS standard screen.
   It is useful to select All when you start an application with the Jog Dial™ navigator.

   Note
   CLIE Launcher groups differ from Palm OS® standard screen categories.
Changing fonts

You can change the font style in applications such as Date Book or Address Book according to your preferences. A font style can be assigned to each application.

1. Start an application whose font style you want to change.

2. Tap the Menu icon.
The menu is displayed.

3. Tap Font from the Options menu.
The Select Font dialog box is displayed.

4. Tap the font style you want to use.

5. Tap OK.
The text in the application is displayed in the font style you selected.

Note
Font style cannot be changed for some applications.
Common menu items

The following list describes functions that are common for the CLIÉ handheld applications such as **Date Book**, **Address Book**, **To Do List**, and **Memo Pad**.

To display the menu, tap the Menu icon while starting the application.

For menu items that are specific to an application, refer to the descriptions of menus for each application.

**Note**

Some menus may not be displayed depending on the display style.

### Edit Menu

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Undo</strong></td>
<td>Reverses the action of the last edit command. For example, if you used Cut to remove text, Undo restores the text you removed.</td>
</tr>
<tr>
<td><strong>Cut</strong></td>
<td>Removes the selected text and stores it temporarily in the memory of your CLIÉ handheld. You can paste the text you cut into another area of the current application or into other applications.</td>
</tr>
<tr>
<td><strong>Copy</strong></td>
<td>Copies the selected text and stores it temporarily in the memory of your CLIÉ handheld. You can paste the text you copied into another area of the current application or into other applications.</td>
</tr>
<tr>
<td><strong>Paste</strong></td>
<td>Inserts the text that you cut or copied at the selected point. If you did not previously cut or copy text, paste has no effect.</td>
</tr>
<tr>
<td><strong>Select All</strong></td>
<td>Selects all of the text in the current record or screen. This function enables you to cut or copy all of the text and paste it at the selected point.</td>
</tr>
</tbody>
</table>

*Continued on next page*
## Common menu items

<table>
<thead>
<tr>
<th><strong>Keyboard</strong></th>
<th>Opens the on-screen keyboard.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Graffiti Help</strong></td>
<td>Opens the list of Graffiti® character strokes. You can view a stroke for a character as needed.</td>
</tr>
</tbody>
</table>
Entering text on your CLIÉ™ handheld

This chapter explains how to enter text on your CLIÉ handheld.

Entering text on your CLIÉ™ handheld .......... 42
Selecting a handwriting input system .......... 43
Using Graffiti® writing to enter text .......... 44
Using Decuma Input to enter text .......... 56
Using the on-screen keyboard to enter text .......... 60
You can enter text by following methods other than the hardware keyboard.

**Handwriting input system**  
**Graffiti® (page 44)**  
Enter text using the freehand input characters, called Graffiti. Once you get used to entering text using Graffiti, it is much faster than entering text with the on-screen keyboard.

**Decuma Input (page 56)**  
Decuma Input converts your handwriting into typed text and can be used to input text with any application. Simply write in the input area in the lower part of the screen. The interpretation of your handwriting appears in the same place as you wrote.

**On-screen keyboard**  
**(Input panel) (page 60)**  
Enter text by tapping the keyboard displayed on the screen.
Selecting a handwriting input system

You can select your favorite handwriting input method: Graffiti® writing or Decuma Input. Your CLIÉ handheld displays the Graffiti® writing as the default setting.

1 Tap the icon on the status bar. The Silk Plug-In dialog box is displayed.

Tip
You can drag the stylus from left to right on the status bar to switch the Silk Screen area. For details, refer to the Silk Plug-In Help by tapping the icon in the Silk Plug-In screen.

2 Select handwriting input system.
When you want to use Graffiti® writing (pages 44-55) Tap StandardInput, then tap OK.

When you want to use Decuma Input (pages 56-59) Tap Decuma Input, then tap OK.
Using Graffiti® writing to enter text

This section describes the procedures for creating letters, numbers, punctuations marks and symbols, and teaches you some Graffiti® tips and tricks.

What is Graffiti writing?

Most people find they can enter text quickly and accurately with only minutes of practice. Graffiti writing includes any character you can type on a standard keyboard. The Graffiti strokes closely resemble the upper case letters of the regular alphabet, which makes Graffiti writing easy to learn.

Entering characters with a single stroke

Most characters require only a single stroke. When you lift the stylus from the Graffiti writing area, your CLIÉ handheld recognizes and displays the text character immediately. To allow you to write an entire character with a single stroke, some Graffiti strokes are just portions of the regular alphabet equivalents.

The dot on each shape shows where to begin the stroke

Certain characters have similar shapes, but different beginning and end points. Always begin the stroke from the dot.

Note

You do not need to create the dot; it is only shown in this manual to illustrate where to begin the stroke.
Using Graffiti® writing to enter text

The areas for writing letters and numbers are different
The Graffiti writing area is divided into two parts: one for writing the letters of the alphabet and one for writing numbers.

Write letters here

Write numbers here

Division marks

Graffiti character list

<table>
<thead>
<tr>
<th>Alphabet</th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>\A</td>
<td>J</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B</td>
<td>B</td>
<td>K</td>
<td></td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>C</td>
<td>L</td>
<td></td>
<td></td>
</tr>
<tr>
<td>D</td>
<td>D</td>
<td>M</td>
<td>m</td>
<td></td>
</tr>
<tr>
<td>E</td>
<td>E</td>
<td>N</td>
<td>N</td>
<td></td>
</tr>
<tr>
<td>F</td>
<td>F</td>
<td>O</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>G</td>
<td>G</td>
<td>P</td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>H</td>
<td>h</td>
<td>Q</td>
<td>q</td>
<td></td>
</tr>
<tr>
<td>I</td>
<td>i</td>
<td>R</td>
<td>R</td>
<td></td>
</tr>
</tbody>
</table>
Using Graffiti® writing to enter text

<table>
<thead>
<tr>
<th>S</th>
<th>W</th>
</tr>
</thead>
<tbody>
<tr>
<td>T</td>
<td>X</td>
</tr>
<tr>
<td>U</td>
<td>Y</td>
</tr>
<tr>
<td>V</td>
<td>Z</td>
</tr>
</tbody>
</table>

**Numbers**

<table>
<thead>
<tr>
<th>0</th>
<th>5</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>6</td>
</tr>
<tr>
<td>2</td>
<td>7</td>
</tr>
<tr>
<td>3</td>
<td>8</td>
</tr>
<tr>
<td>4</td>
<td>9</td>
</tr>
</tbody>
</table>

**Keyboard symbols**

<table>
<thead>
<tr>
<th>Space</th>
<th>Period</th>
</tr>
</thead>
<tbody>
<tr>
<td>Back Space</td>
<td>Tap twice</td>
</tr>
<tr>
<td>Carriage Return</td>
<td>Shift</td>
</tr>
<tr>
<td></td>
<td>Caps</td>
</tr>
</tbody>
</table>
Using Graffiti® writing to enter text

Writing capital letters
Shift to caps to make capital letters with the same stroke shapes as the basic alphabet characters.

• To draw the first letter of a word as a capital letter
  Use the Caps Shift stroke ↓.

![Caps Shift]

To return to lower case, use the BackSpace stroke ——.

Note
When you create a new sentence or a new record (by tapping New or a blank line), the first letter is automatically capitalized.

• To enter only capital letters (Caps Lock)
  Use the Caps Lock stroke ↓↓.

![Caps Lock]

To return to lower case, use the Caps Shift stroke ↓.

Writing punctuation marks
Tap once on the Graffiti writing area to activate Punctuation Shift. The next stroke you make anywhere in the Graffiti area (the letters or numbers side) creates a punctuation mark.

![Punctuation Shift]
<table>
<thead>
<tr>
<th>Punctuation</th>
<th>Graffiti® Writing</th>
</tr>
</thead>
<tbody>
<tr>
<td>. (.) Period</td>
<td>.</td>
</tr>
<tr>
<td>, (,) Comma</td>
<td>,</td>
</tr>
<tr>
<td>' (’) Apostrophe</td>
<td>'</td>
</tr>
<tr>
<td>? (?) Question</td>
<td>?</td>
</tr>
<tr>
<td>! (!) Exclamation</td>
<td>!</td>
</tr>
<tr>
<td>@ (@) At</td>
<td>@</td>
</tr>
<tr>
<td># (#) Number</td>
<td>#</td>
</tr>
<tr>
<td>% (%) Percent</td>
<td>%</td>
</tr>
<tr>
<td>^ (^) Circumflex</td>
<td>^</td>
</tr>
<tr>
<td>&amp; (&amp;) Ampersand</td>
<td>&amp;</td>
</tr>
<tr>
<td>* (*) Asterisk</td>
<td>*</td>
</tr>
<tr>
<td>&lt; (&lt;) Left angle bracket</td>
<td>&lt;</td>
</tr>
<tr>
<td>&gt; (&gt;) Right angle bracket</td>
<td>&gt;</td>
</tr>
<tr>
<td>_ (_) Under bar</td>
<td>_</td>
</tr>
<tr>
<td>” (”) Ditto</td>
<td>”</td>
</tr>
<tr>
<td>(→) Dash</td>
<td>(→)</td>
</tr>
<tr>
<td>( ( ) Left parenthesis</td>
<td>(</td>
</tr>
<tr>
<td>) ( ) Right parenthesis</td>
<td>)</td>
</tr>
<tr>
<td>(/) Slash</td>
<td>(/)</td>
</tr>
<tr>
<td>($) Dollar</td>
<td>($)</td>
</tr>
<tr>
<td>() Back slash</td>
<td>()</td>
</tr>
<tr>
<td>( { ) Left brace</td>
<td>(</td>
</tr>
<tr>
<td>} ) Right brace</td>
<td>)</td>
</tr>
<tr>
<td>[ [) Left square bracket</td>
<td>[</td>
</tr>
<tr>
<td>] ]) Right square bracket</td>
<td>]</td>
</tr>
<tr>
<td>(∼) Swung dash</td>
<td>(∼)</td>
</tr>
<tr>
<td>′ (’) Grave accent</td>
<td>′</td>
</tr>
<tr>
<td>; (;) Semicolon</td>
<td>;</td>
</tr>
<tr>
<td>: (:) Colon</td>
<td>:</td>
</tr>
<tr>
<td>Tab</td>
<td>Tab</td>
</tr>
</tbody>
</table>

**To undo punctuation shift**
Enter —— (Back Space).
### Writing symbols and extended characters

Make a Symbol Shift stroke \( \backslash \) on the Graffiti writing area to activate Symbol Shift. The next stroke you make creates a symbol or extended character.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Stroke</th>
</tr>
</thead>
<tbody>
<tr>
<td>(•) Bullet</td>
<td>•</td>
</tr>
<tr>
<td>(™) Trademark</td>
<td>™</td>
</tr>
<tr>
<td>(©) Registered</td>
<td>©</td>
</tr>
<tr>
<td>(©) Copyrighted</td>
<td>©</td>
</tr>
<tr>
<td>(‘) Left single quotation mark</td>
<td>‘</td>
</tr>
<tr>
<td>(’) Right single quotation mark</td>
<td>’</td>
</tr>
<tr>
<td>(“) Left double quotation mark</td>
<td>(”</td>
</tr>
<tr>
<td>(”) Right double quotation mark</td>
<td>(”)</td>
</tr>
<tr>
<td>(§) Section</td>
<td>§</td>
</tr>
<tr>
<td>(°) Degree</td>
<td>°</td>
</tr>
<tr>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>-</td>
<td>–</td>
</tr>
</tbody>
</table>

To undo symbol shift mode

Enter — (Back Space).
Writing accented characters and non-English characters

To create accented characters, draw the stroke normally used to create the letter, followed by an accent stroke. Graffiti writing then adds the accent to the letter.

To enter “é,” for example, draw \( E \) and then \( / \).

<table>
<thead>
<tr>
<th>accented</th>
<th>Graffiti stroke</th>
</tr>
</thead>
<tbody>
<tr>
<td>à è ì ò û</td>
<td>( \backslash )</td>
</tr>
<tr>
<td>á é í ó ú ý</td>
<td>( / )</td>
</tr>
<tr>
<td>â ê î ô û Ũ</td>
<td>( \wedge )</td>
</tr>
<tr>
<td>ā ò ņ</td>
<td>( \backslash )</td>
</tr>
<tr>
<td>ä ï ö ù ÿ</td>
<td>( \backslash )</td>
</tr>
<tr>
<td>å ç æ</td>
<td>( \oslash )</td>
</tr>
</tbody>
</table>

To write non-English characters

You can write the following characters without any special punctuation or shifting:

<table>
<thead>
<tr>
<th>non-English</th>
<th>Graffiti stroke</th>
</tr>
</thead>
<tbody>
<tr>
<td>ç</td>
<td>( C )</td>
</tr>
<tr>
<td>æ</td>
<td>( E )</td>
</tr>
</tbody>
</table>

**Note**

You must write these non-English characters on the left-hand side of the Graffiti writing area.
Using Graffiti® writing to enter text

Displaying the Graffiti on-screen help
Drag the stylus from the writing area to the top of the screen. Graffiti Help opens a series of screens that show the complete Graffiti character set.

Entering text
To enter text, you will need software (an application) that is compatible with your CLIÉ handheld. Follow the steps below to enter text using Date Book.

1 Tap the Date Book icon on the Application Launcher screen. Date Book starts. Today’s schedule is displayed.
2 Tap the time line in the **Date Book** screen.

3 Use the tables on the previous pages to find the stroke shape for the letter you want to create. There are two different stroke shapes available for some letters. For those letters, choose the one that is easier for you. You use the same shape to create both the upper case and lower case version of a letter.

4 Position the stylus on the left-hand side of the **Graffiti** writing area. Start your stroke at the dot and draw the stroke shape as it appears in the tables.
5 Lift the stylus from the screen at the end of the stroke shape.

When you lift the stylus from the screen, your CLIÉ handheld recognizes your stroke immediately and prints the letter at the insertion point on the screen.

As soon as you lift the stylus from the screen, you can begin the stroke for the next character you want to write.

**Note**

You must begin the character strokes in the Graffiti writing area. If you do not make Graffiti strokes in the Graffiti writing area, your CLIÉ handheld does not recognize them as text characters.

**Notes on writing Graffiti characters**

- Recognition accuracy improves when you write large characters. You should draw strokes that nearly fill the Graffiti writing area.

- Write at natural speed. Writing too slowly can generate recognition errors.

- Do not write on a slant. Vertical strokes should be parallel to the sides of the Graffiti writing area.
Using Navigation strokes and shortcuts

You can navigate within the fields of your application and also quickly enter frequently used symbols, by entering the navigation strokes and shortcuts with Graffiti.

Using navigation strokes

<table>
<thead>
<tr>
<th>Move cursor right</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move cursor left</td>
</tr>
<tr>
<td>Copy or delete data (depending on your settings)</td>
</tr>
<tr>
<td>Go to the previous field (Address Book only)</td>
</tr>
<tr>
<td>Go to the next field (Address Book only)</td>
</tr>
<tr>
<td>Open Address Record (Address Book only)</td>
</tr>
</tbody>
</table>
Using Shortcuts

There are four types of Graffiti Shortcut.
To use a Shortcut, draw the Shortcut stroke  followed by the Shortcut characters.
When you draw the Shortcut stroke, the Shortcut symbol appears at the insertion point to show that you are in Shortcut mode.

The following are the Graffiti Shortcuts that are registered on your CLIÉ handheld:

<table>
<thead>
<tr>
<th>Date stamp</th>
<th>ds</th>
<th>Breakfast</th>
<th>br</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time stamp</td>
<td>ts</td>
<td>Lunch</td>
<td>lu</td>
</tr>
<tr>
<td>Date/time stamps</td>
<td>dts</td>
<td>Dinner</td>
<td>di</td>
</tr>
<tr>
<td>Meeting</td>
<td>me</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

For example, when you enter “dts” using the Graffiti Shortcut, you can enter the current date and time.

Tip
You can also create your own Shortcuts (page 101).
Using Decuma Input to enter text

Decuma Input converts your handwriting into typed text and can be used to input text with any application. Simply write in the input area in the lower part of the screen. The interpretation of your handwriting appears in the same place as you wrote.

Entering text

To enter text, you will need software (an application) that is compatible with your CLIÉ handheld. Follow the steps below to practice entering text using Date Book.

1. Tap the Date Book icon on the Application Launcher screen. Date Book starts. Today’s schedule is displayed.

2. Tap the time line on the Date Book screen.
3 Write on the baseline of the input area.

![Decuma Input screen with Meeting written on baseline]

**Tip**
Write as you normally would.

4 Tap the  icon at the end of the baseline.
The typed text is inserted in the Date Book screen.

![Date Book screen with Meeting entered]

**Tip**
The input text is also inserted in the Date Book screen when you place the stylus before the arrow at the start of the baseline.
The areas for writing letters and numbers are different

Your handwriting can be recognized in two different modes: as general characters and as numbers and special characters.

Other input operations

←, →: Moves the cursor
Space: Inserts a space
←: Deletes the last character
←: Starts a new line behind the cursor
?: Displays the Decuma Latin help screen

Tip

You can drag the stylus from the Decuma Input area to the top of the screen, to display the Decuma Latin help screen.
Changing the Decuma Input settings

1. Tap the Decuma 📱 icon on the Application Launcher screen. The Decuma screen is displayed.

**Shortcuts:**
Defines shortcuts for lengthy text that you write frequently.

**Personalize:**
Edits the Decuma alphabet to adjust individual characters for improved recognition.

**Settings:**
Customizes Decuma Input’s features.

**Info:**
Displays the version of Decuma Input on your CLIÉ handheld.
You can enter text using the stylus of your CLIÉ handheld.

**Entering text**

To enter text, you will need software (an application) that is compatible with your CLIÉ handheld. Follow the steps below to practice entering text using **Date Book**.

1. Tap the Date Book icon on the Application Launcher screen. **Date Book** starts. Today's schedule is displayed.

2. Tap the time line on the **Date Book** screen.
Using the on-screen keyboard to enter text

3 Tap “a” to open the alphabetic keyboard, or tap “1” to open the numeric keyboard.
The selected keyboard is displayed.

Tap here for the alphabetic keyboard

Tap here for the numeric keyboard

Alphabetic

Tab

Caps lock

Caps shift

Back Space

Carriage return

Tap here to display alphabetic keyboard

Tap here to display the numeric keyboard

Tap here to display the international keyboard

4 Select the required keyboard and tap the characters to enter text and numbers.
You can use the on-screen keyboard in the same way as your computer’s keyboard. To enter a capital letter, tap “cap” and then tap the character button. To delete a character, tap \[ \rightarrow \].

Continued on next page
When you have finished, tap **Done** to close the on-screen keyboard and place the text in the record.
Exchanging and updating files/data using the HotSync® operation

This chapter explains how to perform the HotSync® operation with your computer.

What is the HotSync® operation? . . . . . . . . . . .  64
Performing the HotSync® operation . . . . . . . . .  66
Using the Palm™ Desktop for CLIÉ software . . .  68
What is the HotSync® operation?

The HotSync® operation is a one-step operation that enables you to synchronize files/data between your CLIÉ handheld and your computer. With just one press of the HotSync button, you can synchronize your CLIÉ handheld application files/data with the Palm™ Desktop for CLIÉ software files/data on your computer, back up the files/data of your CLIÉ handheld on your computer, and install add-on applications.

1. **Synchronizing the files/data between your CLIÉ handheld and your computer**
   Synchronizes the data of **Date Book**, **Address Book**, **To Do List**, and **Memo Pad** between your CLIÉ handheld and your computer. You can manage the files/data of multiple CLIÉ handhelds separately using the Palm™ Desktop for CLIÉ software.

2. **Saving backup data or applications on your computer**
   Automatically creates a backup of the data or applications currently held in your CLIÉ handheld to your computer. If you delete data or applications by accident, if data or applications are lost by a sudden battery shut-off, or if you need to perform a hard reset, the HotSync® operation allows you to restore the data or applications using the backup data or applications on your computer.
   For details on backing up data and applications, refer to page 172.

Continued on next page
What is the HotSync® operation?

**Tip**
You can save a backup of the data or applications currently held in your CLIÉ handheld onto “Memory Stick” media. For details, refer to “Backing up data and applications to “Memory Stick” media using Memory Stick Backup” (page 173).

3. Using the files/data created in Microsoft® Windows® applications in your CLIÉ handheld
Imports or exports the files/data between a Windows software on your computer and your CLIÉ handheld.

The compatible file formats that you can import/export to the Palm™ Desktop for CLIÉ software
- Comma/Tab delimited (*.csv, *.txt, *.tab, *.tsv)
- Text file (*.txt)
- vCal (Date Book) file (*.vcs)
- vCard (Address) file (*.vcf)
- Date Book archive of the Palm™ Desktop for CLIÉ software (*.dba)
- Address Book archive of the Palm™ Desktop for CLIÉ software (*.aba)
- To Do List archive of the Palm™ Desktop for CLIÉ software (*.tda)
- Memo Pad archive of the Palm™ Desktop for CLIÉ software (*.mpa)

* The words in parentheses are file extensions. Archive is a unit that gathers associated files.

For details on importing/exporting files/data, refer to the online help of the Palm™ Desktop for CLIÉ software.
Performing the HotSync® operation

To perform the HotSync® operation, the Palm™ Desktop for CLIÉ software must be installed on your computer and the cradle should be connected to the computer.

➤ For details on the HotSync® operation, refer to “Using your CLIÉ™ handheld with your computer” in the “Read This First (Operating Instructions).”

Performing the HotSync® operation with the cradle (Local HotSync®)

Performing the HotSync® operation with the cradle is called a Local HotSync®.

1  Place your CLIÉ handheld in the cradle.

2  Press the HotSync button on the cradle.
The HotSync® operation starts.

When the HotSync® operation is complete, a message showing the HotSync® completion is displayed on your CLIÉ handheld.

Continued on next page
Performing the HotSync® operation

**Note**
Do not remove your CLIÉ handheld from the cradle until the HotSync® operation is complete. Also, do not insert or remove “Memory Stick” media or CF card while the HotSync® operation is being performed. Otherwise, the Palm™ Desktop for CLIÉ software may not finish normally.

**If the HotSync® operation does not start**
Make sure that the HotSync  icon is displayed in the Windows task tray.
If the HotSync  icon is not displayed in the task tray, click **Start**, select **Programs** (for Windows XP, select **All Programs**), **Sony Handheld**, and click **HotSync Manager**. Check that the HotSync  icon is displayed in the task tray and press the HotSync  button on the cradle to start the HotSync® operation.
The message is displayed on your computer screen when the HotSync® operation starts.

* From this point onwards, where Windows XP Home Edition and Windows XP Professional are common, they will both be referred to as Windows XP.

**Tip**
**If you cannot perform a HotSync® operation**
Refer to the “Troubleshooting Q&A.”
Using the Palm™ Desktop for CLIÉ software

The Palm™ Desktop for CLIÉ software enables you to view the data transferred from your CLIÉ handheld by the HotSync® operation, on your computer.

Additionally, the Palm™ Desktop for CLIÉ software has the same functions as Date Book, Address Book, To Do List, and Memo Pad so that you can enter or modify schedules or address book data on your computer and export data to your CLIÉ handheld.

Starting the Palm™ Desktop for CLIÉ software

1. Double-click the Palm™ Desktop for CLIÉ icon on the Windows desktop.
   You can also click Start, select Programs (for Windows XP, select All Programs), Sony Handheld, and click Palm Desktop for CLIÉ.
   The Palm™ Desktop for CLIÉ software starts.

Tip

To quit the Palm™ Desktop for CLIÉ software
Click the close button at the top right of the screen or select Exit from the File menu.
Locating components of the Palm™ Desktop for CLIÉ software

1 List pane
Displays the records in the current Desktop application.

2 Application Launch bar
Click an icon to open the associated application.

3 Install icon
Click this icon to display the Install Tool dialog box. You can install applications onto your CLIÉ handheld with the HotSync® operation.
For details, refer to “Installing” on page 187.

4 User selector
Displays the user name of the current information.

Continued on next page
5 Record pane
Displays full details of the record that is selected in the List pane. The information displayed here is the same as that displayed on your CLIÉ handheld’s Details screen.

Basic operations of the Palm™ Desktop for CLIÉ software

Click the icon of the application you want to use. The screen switches to the selected application screen.

Basic operations for each application are the same as those of the corresponding CLIÉ handheld application.

For details on operations, refer to the online help of the Palm™ Desktop for CLIÉ software. To display the online help, select Palm™ Desktop Help from the Help menu.

Tip
Changing the user name of your CLIÉ handheld

1. In the Palm™ Desktop for CLIÉ window, click Users from the Tools menu.
The Users dialog box is displayed.

2. Click the user name you want to change and click Rename.

3. Enter a new user name and click OK.
Your CLIÉ handheld user name is changed at the next HotSync® operation.

Continued on next page
When using the Microsoft® Windows® XP operating system
When you start Palm™ Desktop for CLIÉ software on your computer and select **Custom, File Link, View Log, or Setup** from the **HotSync** menu, the configuration window may open behind the Palm™ Desktop for CLIÉ software window.
In this case, bring the configuration window to the front by performing one of the following:
– Press the Alt and Tab keys at the same time.
– Click the HotSync 🔄 icon at the bottom right of the Windows task tray.
**Customizing your CLIÉ™ handheld (Preferences)**

This chapter explains how to customize your CLIÉ handheld by changing the Preferences settings.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>What you can do with Preferences</td>
<td>73</td>
</tr>
<tr>
<td>Setting the Bluetooth™ function (for Bluetooth™ built-in models only)</td>
<td>75</td>
</tr>
<tr>
<td>Assigning applications to application buttons</td>
<td>78</td>
</tr>
<tr>
<td>Customizing the full-screen pen stroke activities</td>
<td>79</td>
</tr>
<tr>
<td>Assigning applications to HotSync buttons</td>
<td>80</td>
</tr>
<tr>
<td>Adding/Changing communication device preferences</td>
<td>81</td>
</tr>
<tr>
<td>Setting up the Date &amp; Time preferences</td>
<td>83</td>
</tr>
<tr>
<td>Adjusting the Digitizer</td>
<td>86</td>
</tr>
<tr>
<td>Setting the display format of the time, date, and numbers</td>
<td>87</td>
</tr>
<tr>
<td>Setting the automatic power-off time</td>
<td>88</td>
</tr>
<tr>
<td>Setting sounds</td>
<td>89</td>
</tr>
<tr>
<td>Turning the Alarm LED on or off</td>
<td>90</td>
</tr>
<tr>
<td>Turning the Beam Receive feature on or off</td>
<td>91</td>
</tr>
<tr>
<td>Changing the Network preferences</td>
<td>92</td>
</tr>
<tr>
<td>Creating Graffiti® ShortCuts</td>
<td>101</td>
</tr>
</tbody>
</table>
What you can do with Preferences

The Preferences screen enables you to customize the configuration options on your CLIÉ handheld.
Setting options may be added by installing new application or software for peripheral devices.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bluetooth</td>
<td>Sets the configuration for the Bluetooth™ function.</td>
</tr>
<tr>
<td></td>
<td>➤ For details, refer to page 75. (for Bluetooth™ built-in models only)</td>
</tr>
<tr>
<td>Buttons</td>
<td>Customizes applications assigned to application buttons and a HotSync button, and the full-screen pen stroke activities.</td>
</tr>
<tr>
<td></td>
<td>➤ For details, refer to pages 78 to 80.</td>
</tr>
<tr>
<td>Connection</td>
<td>Sets the configuration for the communication device.</td>
</tr>
<tr>
<td></td>
<td>➤ For details, refer to page 81.</td>
</tr>
<tr>
<td>Date &amp; Time</td>
<td>Sets the current date, time, time zone and daylight saving configuration.</td>
</tr>
<tr>
<td></td>
<td>➤ For details, refer to page 83.</td>
</tr>
<tr>
<td>Digitizer</td>
<td>Calibrates the screen of your CLIÉ handheld.</td>
</tr>
<tr>
<td></td>
<td>➤ For details, refer to page 86.</td>
</tr>
<tr>
<td>Formats</td>
<td>Sets the formats for time or date.</td>
</tr>
<tr>
<td></td>
<td>➤ For details, refer to page 87.</td>
</tr>
<tr>
<td>General</td>
<td>Sets the general configurations such as system sound, LED feature* and auto shut-off interval. (*not available on certain models)</td>
</tr>
<tr>
<td></td>
<td>➤ For details, refer to pages 88 to 91.</td>
</tr>
<tr>
<td>Network</td>
<td>Sets the Internet connection configuration.</td>
</tr>
<tr>
<td></td>
<td>➤ For details, refer to page 92.</td>
</tr>
<tr>
<td>Owner</td>
<td>Sets the owner information, such as name and phone number.</td>
</tr>
<tr>
<td></td>
<td>➤ For details, refer to page 177.</td>
</tr>
<tr>
<td>ShortCuts</td>
<td>Defines a list of Graffiti® abbreviations.</td>
</tr>
<tr>
<td></td>
<td>➤ For details, refer to page 101.</td>
</tr>
</tbody>
</table>

Tip

For the setting options not mentioned above, refer to the “Read This First (Operating Instructions).”

Continued on next page
Displaying the Preferences screen for each menu

1 Rotate the Jog Dial™ navigator to select the Prefs icon on the Application Launcher screen and press the Jog Dial™ navigator.
The Preferences screen is displayed.

**Tip**
You can also tap the Prefs icon to display the Preferences screen.

2 Tap the arrow ▼ at the top right of the screen and select the Preferences menu you want to configure.
Setting the Bluetooth™ function
(for Bluetooth™ built-in models only)

Note
You cannot use the Bluetooth™ function while the Bluetooth Preferences screen is displayed.

Turning the Bluetooth™ function on or off
You can turn the Bluetooth™ function on or off.
When you disable the Bluetooth™ function, you cannot send data by the function but your CLIÉ handheld’s battery is conserved. By default, the Bluetooth™ function is disabled.

1 Tap the arrow ▼ at the top right of the Preferences screen and select Bluetooth.
The Bluetooth Preferences screen is displayed.

2 Tap the arrow ▼ next to Bluetooth and select Enabled or Disabled.
   • Enabled: Turns on the Bluetooth™ function. The Bluetooth LED lights up or blinks.
   • Disabled: Turns off the Bluetooth™ function.
### Setting the Bluetooth™ function (for Bluetooth™ built-in models only)

**Viewing/Customizing Bluetooth™ information**

When the Bluetooth™ function is enabled, the following items are displayed on the **Bluetooth Preferences** screen:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Device name</strong></td>
<td>You can enter a name for your CLIÉ handheld. A device name is required for each CLIÉ handheld to be identified. You can display the name setup window by tapping the square box.</td>
</tr>
<tr>
<td><strong>Allow Device to be Discovered</strong></td>
<td>Yes: Another Bluetooth™ compatible device detects your CLIÉ handheld as a target Bluetooth™ compatible device. No: Another Bluetooth™ compatible device does not detect your CLIÉ handheld as a target Bluetooth™ compatible device. (Default: Yes)</td>
</tr>
<tr>
<td><strong>Allow Wake Up</strong></td>
<td>Yes: Another Bluetooth™ compatible device can turn on your CLIÉ handheld automatically and detect your CLIÉ handheld as a target Bluetooth™ compatible device when your CLIÉ handheld is turned off. (The Bluetooth LED blinks while this feature is enabled.) No: Another Bluetooth™ compatible device cannot detect your CLIÉ handheld as a target Bluetooth™ compatible device when your CLIÉ handheld is turned off. (Default: No)</td>
</tr>
<tr>
<td><strong>Device Address</strong></td>
<td>You can display the device address (identification number of Bluetooth™ device) of your CLIÉ handheld. The device address cannot be edited.</td>
</tr>
</tbody>
</table>

You can change your device name cache settings by tapping the **Menu** icon on the **Bluetooth Preferences** screen. Tap **Enable device name cache** or **Disable device name cache**.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Enable device name cache</strong></td>
<td>The list of device names registered on your CLIÉ handheld is displayed. The most current device names might not be displayed. (The name list will be updated after you connect to the Bluetooth™ compatible device.)</td>
</tr>
<tr>
<td><strong>Disable device name cache</strong></td>
<td>Another Bluetooth™ compatible device will be detected whether or not that device name is registered on your CLIÉ handheld. Discovery will be slower, but the most current device names will be displayed. (Default: Enable device name cache)</td>
</tr>
</tbody>
</table>
Displaying/Deleting the information of target Bluetooth™ compatible devices

You can view information of Bluetooth™ compatible devices registered on your CLIÉ handheld or delete unnecessary information.

1 Tap the arrow ▼ at the top right of the Preferences screen and select Bluetooth. The Bluetooth Preferences screen is displayed.

2 Tap Trusted Devices. The Bluetooth™ compatible devices registered on your CLIÉ handheld are displayed.

3 Select the device whose information you want to display, and tap Details…. The Device Details dialog box is displayed. Tap Done to return to the Trusted Devices screen.

4 To delete the information of the selected device, tap Delete Device. When the confirmation dialog box is displayed, tap OK.

5 Tap Done to return to the Bluetooth Preferences screen.

Adding information of target Bluetooth™ compatible devices
Tap Add Device in the Trusted Devices dialog box and follow the on-screen instructions.
Assigning applications to application buttons

You can assign your favorite applications to the application buttons on the front panel of your CLIÉ handheld.

For example, you can assign the Date Book button to start Calculator.

The position of the application buttons varies depending on your model.

For details, refer to “CLIÉ™ handheld components” in the “Read This First (Operating Instructions).”

1. Tap the arrow ▼ at the top right of the Preferences screen and select Buttons.

   The Buttons Preferences screen is displayed.

2. Tap the arrow ▼ next to the icon and select the application you want to assign.

   The application button is changed.

To start the original applications

If you assign another application to a button, you can still start the original application from the Application Launcher screen.

To reset to default settings

Tap Default in step 2.

All application buttons are reset to their factory settings.
Customizing the full-screen pen stroke activities

You can customize the assignment of the full-screen pen stroke. (Can be performed only when the Silk Screen area is displayed.)

The full-screen pen stroke will display the help screen of the input method you have selected for the Silk Screen area.

1. Tap the arrow ▼ at the top right of the Preferences screen and select Buttons.

2. Tap Pen. The Pen screen is displayed.

3. Tap the arrow ▼ next to Graffiti Help and select the settings for the full-screen pen stroke.

   Tip

   Press the Ctrl key and R key on the keyboard at the same time.
   You can also display the Graffiti Help screen for the full-screen pen stroke.

   Backlight
   Turns on the backlight of your CLIÉ handheld without using the POWER button.

   Brightness
   Opens the Adjust Brightness screen.

   Keyboard
   Opens the on-screen keyboard for entering text.

   Graffiti Help
   Opens a series of screens that show the complete Graffiti character set.

   Turn Off & Lock
   Turns off and locks your CLIÉ handheld. To turn on your CLIÉ handheld when it is locked, you must enter a password.
   ➔ For details, refer to “Protecting your data with a password” (page 176).

   Beam Data
   Beams the current record to another Palm OS PDA.

4. Tap OK.
Assigning applications to HotSync buttons

You can assign your favorite applications to the HotSync buttons on the cradle and modem (if a HotSync button is provided).

1. Tap the arrow ▼ at the top right of the Preferences screen and select Buttons.

2. Tap HotSync.

3. Tap the arrow ▼ next to a button and select the application you want to assign.

4. Tap OK.
The Buttons Preferences screen is displayed.
You can start the selected application by pressing the HotSync button.
Adding/Changing communication device preferences

You can customize the preference for a communication device to be connected to your CLIÉ handheld. The applications using the communication device will comply with this preference.

1 Tap the arrow ▼ at the top right of the Preferences screen and select Connection.

2 Tap New.
To change the existing preference, tap the preference you want to change and Edit.

3 Enter the connection name in Name.
Enter a suitable name.

4 Tap the arrow ▼ next to Connect to and select how you connect your CLIÉ handheld to your computer.

5 Tap the arrow ▼ next to Via and select what you use to connect your CLIÉ handheld to your computer.

If you select a modem for Connect to
① Tap the arrow ▼ next to Dialing and select the type of line you want to use.
The recommended setting is TouchTone™.
Do not select Rotary unless you are sure that the telephone service being used is not TouchTone™.
② Tap the arrow ▼ next to Volume and select the volume of the modem speaker at the time of connection.
③ Tap Details.
④ Tap the arrow ▼ next to Speed and select the maximum speed for the transmission between the modem and CLIÉ handheld.
⑤ Tap the arrow ▼ next to Flow Ctl and select the flow control of the modem connection.
The recommended setting is Automatic.
⑥ Enter the modem initialization command in Init String.
By default, it is set to either AT&FX4 or ATZ. If the modem initialization command is not specified on the modem, changes are not required.
⑦ Tap OK.  

Continued on next page
6 Tap OK.
The configuration for the communication device is changed and the Preferences screen is displayed.
Setting up the Date & Time preferences

You can set the date, time, time zone, and daylight savings on/off for your CLIÉ handheld. After you set the local date and time of your home base, you can change the displayed time (for example, during business trips) simply by switching the time zones.

Setting the date

1. Tap the arrow ▼ at the top right of the Preferences screen and select Date & Time. The Date & Time Preferences screen is displayed.

2. Tap Set Date. The Set Date screen is displayed.

3. Tap the arrow ◀ or ▶ beside the year at the top of the screen to set the year.

4. Tap the current month.

5. Tap the current date.
Setting up the Date & Time preferences

**Setting the time**

1. Tap the arrow ▼ at the top right of the **Preferences** screen and select **Date & Time**.
   The **Date & Time Preferences** screen is displayed.

2. Tap **Set Time**.
   The **Set Time** screen is displayed.

3. Tap the arrow ▼ or ▲ to set the hour.

4. Tap the minute box and tap the arrow ▼ or ▲ to set the minute.

5. Tap **AM** or **PM**.

6. Tap **OK**.
Setting the time zone and daylight saving time

**Setting the time zone**

1. Tap the arrow ▼ at the top right of the Preferences screen and select Date & Time.  
The Date & Time Preferences screen is displayed.

2. Tap the Set Time Zone field.  
The Set Time Zone screen is displayed.

3. Select the time zone of your region.

4. Tap OK.

**Setting the daylight saving time**

1. Tap the arrow ▼ at the top right of the Preferences screen and select Date & Time.  
The Date & Time Preferences screen is displayed.

2. Tap the arrow ▼ next to Daylight Saving.

3. Tap On or Off.
Adjusting the Digitizer

You need to adjust the digitizer when performing a hard reset, when the tapping operation or scrolling does not work properly, or when you cannot adjust the brightness of the backlight or screen contrast.

1. Tap the arrow ▼ at the top right of the Preferences screen and select Digitizer.
   The Digitizer calibration screen is displayed.

   ![Use stylus to tap center of target.]

   This Digitizer calibration screen is the same as the screen displayed the first time you turned on your CLIÉ handheld. Follow the on-screen instructions to adjust the digitizer.

   **Tip**
   Use the stylus perpendicular to the screen to tap targets.
Setting the display format of the time, date, and numbers

Selecting a regional default

When you select the region where you use your CLIÉ handheld, the display format of the time, date, week start day, and numbers are adjusted to the regional default. For example, in the United Kingdom, time is expressed using a 24-hour clock; in the United States, time is expressed using a 12-hour clock with an AM or PM suffix.

The regional default setting is applied to the display formats of all your CLIÉ handheld applications. However, you can customize your own settings for each unit, such as time or date.

1. Tap the arrow ▼ at the top right of the Preferences screen and select Formats.

2. Tap the arrow ▼ next to Preset to and select a region name.

Customizing your own settings for each unit

You can customize your own settings for the display formats of the time, date, week start day, and numbers. The settings are applied to the display formats of all your CLIÉ handheld applications.

1. Tap the arrow ▼ at the top right of the Preferences screen and select Formats.

2. Tap the arrow ▼ next to Time and select the desired format.

3. Tap the arrow ▼ next to Date and select the desired format.

4. Tap the arrow ▼ next to Week starts and select Sunday or Monday.

   This setting is applied to the Day, Week, Month, and Agenda views in Date Book and all other applications displaying calendars.

5. Tap the arrow ▼ next to Numbers and select the desired format.
Setting the automatic power-off time

Your CLIÉ handheld has an automatic power-off feature that turns off after a period of inactivity to conserve your CLIÉ handheld battery. You can adjust the time setting for the automatic power-off feature. By default, your CLIÉ handheld will turn off after two minutes of inactivity and will remain on when connected to the cradle.

1. Tap the arrow ▼ at the top right of the Preferences screen and select General.
   The General Preferences screen is displayed.

2. Tap the arrow ▼ next to Auto-off After and select the desired time.
   You can select 30 seconds, 1 minute, 2 minutes, or 3 minutes.

3. If you want to leave your CLIÉ handheld turned on while it is connected to the cradle, tap the Stay on in Cradle check box.

Note
If you tap Auto Lock Handheld to lock in the Security screen (page 180), the Stay on in Cradle function is cancelled, and the data protection takes priority.
Setting sounds

You can adjust the volume level of the system sounds, alarm sounds, and game sounds, or turn the sound off completely.

1. Tap the arrow ▼ at the top right of the Preferences screen and select General.
   The General Preferences screen is displayed.

2. Tap the arrow ▼ next to System Sound and select the desired volume level or Off.
   When the System Sound is turned off, the chime tones associated with the HotSync® operation are also turned off.

3. Tap the arrow ▼ next to Alarm Sound and select the desired volume level or Off.

4. Tap the arrow ▼ next to Game Sound and select the desired volume level or Off.
   The Game Sound setting is only applied to the games programmed to respond to this setting.
Turning the Alarm LED on or off

You can set the CLIÉ handheld to flash its LED at a set time. If you turn the Alarm Sound off and turn the Alarm LED on, you can use the alarm feature without disturbing people around you.

1. Tap the arrow ▽ at the top right of the Preferences screen and select General. The General Preferences screen is displayed.

2. Tap the arrow ▽ next to Alarm LED and select On or Off.
Turning the Beam Receive feature on or off

You can turn on or off the Beam Receive feature. When you turn off the Beam Receive feature, you cannot receive data via beaming but your CLIÉ handheld battery is conserved. By default, the Beam Receive feature is set to On.

1. Tap the arrow ▼ at the top right of the Preferences screen and select General.

2. Tap the arrow ▼ next to Beam Receive and select On or Off.
   - On: Enables the Beam Receive feature.
   - Off: Disables the Beam Receive feature.
Changing the Network preferences

**Note**
For the settings specific to a peripheral device, refer to the manual of that device.

---

**Selecting a service template**
You can customize the Service setting to select the service template for your Internet Service Provider or a dial-in server.

1. Tap the arrow ▼ at the top right of the **Preferences** screen and select **Network**.
   The **Network Preferences** screen is displayed.

2. Tap the arrow ▼ next to **Service** and select the service template (**Internet Service Provider name**) you want to use.

**Tips**
- To add a new service template, select **New** from the **Service** menu.
  If the Internet Service Provider name you want to use is not displayed in the list, tap the area showing the service template, or select **New** from the **Service** menu, and enter the new Internet Service Provider name.
  You can create multiple service templates for your Internet Service Provider. You need to name them so that those service templates are uniquely identified, such as “So-net1” and “So-net2.” This is useful when using your Internet Service Provider by access point. It is also useful when setting the service template.
- If you want to copy an existing service template without changing, select **Duplicate** from the **Service** menu.
Changing the Network preferences

Entering a user name

The User Name setting identifies the name you use when you log into your Internet Service Provider (ISP) or dial-in server.

1 Tap the **User Name** field on the **Network Preferences** screen.

2 Enter your user name.

**Notes**

- Although this field can contain multiple lines of text, only two lines appear on-screen.
- Most dial-in servers do not accept spaces in the user name.

Entering a password

The Password setting identifies the password you use to log into your server or ISP. Your entry in this field determines whether your CLIÉ handheld prompts you to enter a password each time you log into your network:

- If you do not enter a password, your CLIÉ handheld displays the word **-Prompt-** in this field and asks you to enter a password during the log-in procedure.
- If you enter a password, your CLIÉ handheld displays the word **-Assigned-** in this field and does not prompt you to enter a password during the log-in procedure.

**Note**

If you are concerned about security, select the **-Prompt-** and do not enter a password.

1 Tap the **Password** field on the **Network Preferences** screen.

2 Enter the password you use to log into your server.

3 Tap **OK**. The **Password** field changes to display the word **-Assigned-**.
Changing the Network preferences

Selecting a connection

Use the Connection setting to select the method you want to use to connect to your Internet Service Provider (ISP) or a dial-in server.

1. Tap the arrow ▼ next to Connection and select Standard Modem on the Network Preferences screen.

Adding detailed information to a service template

If you are using one of the predefined service templates, you probably only need to enter your user name and telephone number. If you are creating a new service template, you may need to provide additional information to your ISP or dial-in server. Use the Details dialog box to add additional information to a selected service template.

To select a connection type

1. Tap the Service field on the Network Preferences screen.

2. Tap Details.
   The Details screen is displayed.

3. Tap the arrow ▼ next to Connection type and select one of the following connection types.
   • PPP: Point-to-Point Protocol
   • SLIP: Serial Line Internet Protocol
   • CSLIP: Compressed Serial Line Internet Protocol

   Tip
   If you are not sure, try PPP; if that doesn't work, ask your Internet Service Provider (ISP) or your System Administrator for the correct connection type.
4 Tap the arrow ▼ next to Idle timeout and select one of the following options.
   • **1 Minute**: Waits one minute before dropping the connection when you open another application that does not use the network.
   • **2 Minutes**: Waits two minutes.
   • **3 Minutes**: Waits three minutes.
   • **Never**: Keeps your PPP or SLIP connection open until you turn off your CLIÉ handheld (or until it times out).
     Note that this option will be more costly than others.

5 Tap the **Query DNS** check box to deselected it.

6 Enter the IP address for the Primary and Secondary DNS (Domain Naming System).
   Ask your ISP or System Administrator for the correct Primary or Secondary DNS IP numbers.

7 If you need to enter the CLIÉ handheld's IP Address, tap the **IP Address** check box and display a permanent IP address field beneath the check box.
   Normally, you do not need to enter this IP address. If you are not sure, select Automatic and go to step 9.

8 Enter the CLIÉ handheld's IP Address.

9 Tap **OK**.
Changing the Network preferences

Creating additional service templates

You can create additional service templates from scratch or by duplicating existing templates and editing the information. After you create a new or duplicate template, you can add and edit settings.

To duplicate an existing service template

1 Tap the arrow ▼ next to Service and select the predefined service template you want to duplicate on the Network Preferences screen.

2 Tap the Menu icon. The menu screen is displayed.

3 Tap Duplicate from the Service menu. A copy of the service template (The name of an original service template + Copy) is added to the drop-down list for the Service field.

To delete a service template

You can delete an existing service template.

1 Tap the arrow ▼ next to Service and select the predefined service template you want to delete on the Network Preferences screen.

2 Tap the Menu icon. The menu screen is displayed.

3 Tap Delete from the Service menu. The Delete Service dialog box is displayed.

4 Tap OK. The selected service template is deleted. To cancel deleting, tap Cancel.
Creating log-in scripts

A log-in script is a series of commands that automates logging in to a network server, such as your corporate network or your Internet Service Provider (ISP). You can also use non-ASCII characters or literal characters for Log-in Scripts. ➔ For details, refer to “Non-ASCII Characters for Log-in Scripts” on page 99.

1 Tap the Service field on the Network Preferences screen.

2 Tap Details.
   The Details screen is displayed.

3 Tap Script.
   The Log-in Script screen is displayed.

4 Tap the arrow ▼ next to End and select one of the following commands.
   If the command requires additional information, a field appears to the right of it for you to enter the information.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wait For</td>
<td>Makes your CLIÉ handheld wait for specific characters from the TCP/IP server before executing the next command.</td>
</tr>
<tr>
<td>Wait For Prompt</td>
<td>Detects a challenge-response prompt coming from the server and displays the dynamically generated challenge value. Then enter the challenge value into your token card, which in turn generates a response value for you to enter on your CLIÉ handheld. This command takes two arguments, separated by a vertical bar (</td>
</tr>
<tr>
<td>Send</td>
<td>Transmits specific characters to the TCP/IP server to which you are connecting.</td>
</tr>
<tr>
<td>Send CR</td>
<td>Transmits a carriage return or LF character to the TCP/IP server to which you are connecting.</td>
</tr>
<tr>
<td>Send User ID</td>
<td>Transmits the User ID information entered in the User ID field of the Network Preferences screen.</td>
</tr>
<tr>
<td>Send Password</td>
<td>Transmits the password entered in the Password field of the Network Preferences screen. If you did not enter a password, this command prompts you to enter one. The Password command is usually followed by a Send CR command.</td>
</tr>
</tbody>
</table>
### Changing the Network preferences

<table>
<thead>
<tr>
<th>Delay</th>
<th>Makes your CLIÉ handheld wait a specific number of seconds before executing the next command in the log-in script.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get IP</td>
<td>Reads an IP address and uses it as the IP address for your CLIÉ handheld. This command is used with SLIP connections.</td>
</tr>
<tr>
<td>Prompt</td>
<td>Opens a dialog box and prompts you to enter text (for example, a password or a security code).</td>
</tr>
<tr>
<td>End</td>
<td>Identifies the last line in the log-in script.</td>
</tr>
</tbody>
</table>

5 Repeat step 4 until the log-in script is complete.

6 Tap OK.
The **Details** screen is displayed.

7 Tap OK.
The **Network Preferences** screen is displayed.
Non-ASCII Characters for Log-in Scripts
The following information enables you to create custom log-in scripts that require non-ASCII characters. It is provided for advanced users who understand the use and requirements of such characters in a custom log-in script.

Use of ^char
You may use the caret (^) to transmit ASCII command characters. If you send ^char, and the ASCII value of character is between @ and _, then the character is automatically translated to a single-byte value between 0 and 31.
For example, ^M is converted to a carriage return.
If character is a value between A and Z, then the character sequence is translated to a single-byte value between 1 and 26. If character is any other value, then the character sequence is not subject to any special processing. For example, the string “Joe^M” transmits Joe, followed by a carriage return.

Carriage return and line feed
You may include carriage return and line feed commands as part of the log-in script, when they are entered in the following format.
• <cr> : Sends or receives a carriage return
• <lf> : Sends or receives a line feed
For example, the string “waitfor Joe<cr><lf>” waits to receive Joe followed by a carriage return and line feed from the remote computer, before executing the next command in the script.

Literal characters
The backslash (\) character defines that the next character is transmitted as a literal character, and is not subject to any special processing ordinarily associated with that character.
Examples:
• \^ : Includes a caret as part of the string
• \< : Includes a < as part of the string
• \\ : Includes a backslash as part of the string
Changing the Network preferences

Using the Network preferences menus

This section describes the menu commands specific to network preferences. For the menu commands that are common for the CLIÉ handheld applications, refer to “Common menu items” on page 39.

Service menus

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Creates a new service template.</td>
</tr>
<tr>
<td>Delete...</td>
<td>Deletes the current service template.</td>
</tr>
<tr>
<td>Duplicate</td>
<td>Duplicates the current service template.</td>
</tr>
</tbody>
</table>

Option menus

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Log</td>
<td>Displays the Network Log screen that lists the history of your Internet connection. Tap Done to close the Network Log screen.</td>
</tr>
</tbody>
</table>
Creating Graffiti® ShortCuts

You can create abbreviations (ShortCuts) for entering text with Graffiti® strokes.

➤ For details on using Graffiti® ShortCuts, refer to “Using Shortcuts” on page 55.

1 Tap the arrow ▼ at the top right of the Preferences screen and select ShortCuts.

2 Tap New.
The ShortCut Entry screen is displayed.

3 Enter the ShortCut name and an abbreviation (character string).

4 Tap OK.
The new ShortCut is created and the list of ShortCuts is displayed.

To Edit a ShortCut

1 Tap the ShortCut you want to edit and tap Edit.

2 Edit the ShortCut name or the abbreviation (character string) and tap OK.

To Delete a ShortCut

1 Tap the ShortCut you want to delete and tap Delete.
A confirmation message is displayed.

2 Tap Yes.
The selected ShortCut is deleted.
Exchanging and updating files/data using the HotSync® operation (Other HotSync® operations)

This chapter explains how to select HotSync® operating options and how to perform the HotSync® operation via the cradle, infrared communications port, or network. Other advanced HotSync® operations include how to use file link functions and how to import data from Windows applications.

Customizing HotSync® application settings (Conduit) ............................................. 103
Synchronizing with external data (File Link) ......................................................... 105
Customizing HotSync® Manager startup and HotSync® setup options .................. 106
Performing the IR HotSync® operation ................................................................. 107
Performing the HotSync® operation using the Bluetooth™ function (for Bluetooth™ built-in models only) ................................................................. 110
Performing the HotSync® operation via a modem .................................................. 114
Performing the HotSync® operation via a network ............................................... 120
Performing the HotSync® operation via LAN (LANSync) ....................................... 124
Customizing HotSync® application settings (Conduit)

A program handling the data of an application during the HotSync® operation is called a “conduit.”

For each application, you can define a set of options that determine how data is handled during synchronization. By default, the HotSync® operation synchronizes all files/data between your CLIÉ handheld and the Palm™ Desktop for CLIÉ software.

In addition to the conduits for Date Book, Address Book, To Do List, and Memo Pad, the Palm™ Desktop for CLIÉ software offers System and Install conduits. The System conduit backs up the system information stored on your CLIÉ handheld. The Install conduit installs add-on applications to your CLIÉ handheld. You can select them as needed.

1. Click the HotSync ® icon in the Windows task tray (at the bottom right of the taskbar) and select Custom from the HotSync® Manager menu.
   You can also select Custom from the HotSync menu of the Palm™ Desktop for CLIÉ software.
   The Custom dialog box is displayed.

2. Select the user name you are using on your CLIÉ handheld from the list at the top.

3. Select an application in the Conduit list.

Continued on next page
4 Click **Change**. The **Change HotSync Action** dialog box is displayed.

5 Click to select one of the following:
   - **Synchronize the files**
   - **Desktop overwrites handheld**
   - **Handheld overwrites Desktop**
   - **Do nothing**

6 Click **OK**.

7 Repeat steps 2 to 6 to customize conduit settings for other applications (or other users).

8 Click **Done**. The conduit setting is changed.

**Notes**
- The conduit setting is applied only to the next HotSync® operation. Thereafter, the HotSync Actions revert to their default settings. To set a new setting as the default, in step 5, select the **Set as default** check box.
- To restore the default settings, click **Default** in the **Custom** dialog box.
Synchronizing with external data (File Link)

You can synchronize Address Book or Memo Pad data in your CLIÉ handheld with external files such as address book data in your computer (File Link). HotSync® Manager stores the files in your computer in a separate category on your Palm™ Desktop for CLIÉ software and your CLIÉ handheld. You can set the File Link feature to start synchronization only when the external file has been updated.

Compatible file formats that you can import with File Link:
- Comma delimited (*.csv)
- Memo Pad archive of the Palm™ Desktop for CLIÉ software (*.mpa)
- Address Book archive of the Palm™ Desktop for CLIÉ software (*.aba)
- Text file (*.txt)

* The words in parentheses are file extensions. Archive is a unit that gathers associated files.

For details on how to set up File Link, refer to the online help of the Palm™ Desktop for CLIÉ software.
Customizing HotSync® Manager startup and HotSync® setup options

1. Click the HotSync® icon in the Windows task tray (at the bottom right of the taskbar) and select Setup from the shortcut menu. The Setup dialog box is displayed.

2. Click the General tab and select the setting as needed. If you are not sure which option to use, select Always available.
   - **Always available:** Starts the HotSync® Manager when Windows starts. This allows you to perform a HotSync® operation even when the Palm™ Desktop for CLIE software is not running.
   - **Available only when the Palm Desktop is running:** Starts the HotSync® Manager when you start the Palm™ Desktop for CLIE software.
   - **Manual:** Starts the HotSync® Manager only when you select HotSync® Manager from the Start menu in Windows.

3. Click the Local tab and adjust the setting for the connection between the computer and cradle as needed.
   - **Serial port:** Specifies the computer port that is used for a HotSync® operation. Make sure that the serial port for HotSync® is not shared with the port for modem.
   - **Speed:** Determines the speed at which files/data are transferred. Try the As Fast As Possible rate first, and adjust downward if you have any problems.

4. Click the Modem tab and select the setting for the modem as needed.
   ➔ For details, refer to “Performing the HotSync® operation via a modem” on page 114.

5. Click the Network tab and select the setting for the network as needed.

6. Click OK to finish.
Performing the IR HotSync® operation

You can use the IR (infrared) port of your CLIÉ handheld to perform the IR HotSync® operation with a computer equipped with an IrDA (Infrared Data Association) IR port. The IR HotSync® operation enables you to perform a HotSync® operation without using the cradle.

Prior to performing the IR HotSync® operation
Check the following items:
• Your computer is equipped with an infrared port supporting the IrDA standard.
• The infrared port of your computer is enabled for use with your Windows operating system.
• Check the port number allocated to the infrared port.
• The infrared port number is available in the Infrared Monitor in the Control Panel.
  For details on the Infrared Monitor, refer to the manual of your computer or the Windows online help.

Preparing your computer
To perform the IR HotSync® operation, you need to allocate a virtual port to the IR HotSync® operation.

For Windows 2000 Professional/Windows XP

1  Click the HotSync icon in the Windows task tray (at the bottom right of the taskbar) and select IR from the shortcut menu.
  IR HotSync® operation is enabled.

For Windows 98 Second Edition/Me

1  Click the HotSync icon in the Windows task tray (at the bottom right of the taskbar) and check Local Serial from the shortcut menu.

Continued on next page
Performing the IR HotSync® operation

2 Click the HotSync icon in the Windows task tray (at the bottom right of the taskbar) once again and select Setup from the shortcut menu.
   The Setup dialog box is displayed.

3 Click the Local tab.

4 Adjust the following settings as needed.
   • **Serial port**: Specifies a virtual port for an infrared port. If you are not sure of the connection port, refer to the Infrared Monitor in the Control Panel.
   • **Speed**: Determines the speed at which files/data are transferred. Try the As Fast As Possible rate first, and adjust downward if you have any problems.

5 Tap OK.
   The IR HotSync® operation is enabled.

**Note**
When performing a local HotSync® operation with the cradle, you need to restore the local HotSync settings.
▶ For details, refer to “To restore the local HotSync settings” on page 109.
Performing the IR HotSync® operation

You can perform the IR HotSync® operation when you have prepared your computer settings, CLIÉ handheld settings, and Conduit Setup.

1 Rotate the Jog Dial™ navigator to select the HotSync icon on the Application Launcher screen and press the Jog Dial™ navigator.
   The HotSync screen is displayed.

   **Tip**
   You can also tap the HotSync icon to display the HotSync screen.

2 Tap Local.

3 Tap the arrow ▼ and select **IR to a PC/Handheld**.

4 Point the IR port of your CLIÉ handheld directly to the IR port of the computer.
   For best results, your computer and your CLIÉ handheld should be 4 to 8 inches (approximately 10 to 20 centimeters) apart, and the path between your CLIÉ handheld and the computer must be clear of obstacles.

5 Tap the HotSync icon.
   The HotSync® operation starts.
   A message will be displayed when the HotSync® operation is complete.

**To restore the local HotSync settings**

When performing the local HotSync® operation with the cradle, you need to restore the local HotSync settings.

1 Connect the cradle to your computer.

2 Click the HotSync icon in the Windows task tray (at the bottom right of the taskbar) and select **Local USB** from the shortcut menu.
Performing the HotSync® operation using the Bluetooth™ function (for Bluetooth™ built-in models only)

If you are using a Bluetooth™ compatible computer, you can perform a wireless HotSync® operation between your CLIÉ handheld and computer.

Prior to performing the HotSync® operation using the Bluetooth™ function
To perform the HotSync® operation between your CLIÉ handheld and computer using the Bluetooth™ function, you need to configure a new connection setting for Bluetooth™ to register your computer as a target device.

Preparing your CLIÉ handheld

Note
Prior to performing the following procedure, enable the Bluetooth™ function of your computer. For details, refer to the manual of your computer.

1. Tap the arrow ▼ at the top right of the Preferences screen and select Connection.

2. Tap New....

3. Enter name.
Enter a unique name for each computer.
Custom is displayed by default.

4. Tap the arrow ▼ next to Connect to and select PC.

5. Tap the arrow ▼ next to Via and select Bluetooth.

6. Tap Tap to discover next to Device.
Your CLIÉ handheld starts to detect Bluetooth™ compatible devices located within a range of the communication area.
When detection is complete, Bluetooth™ compatible devices around your CLIÉ handheld are listed.

Continued on next page
Performing the HotSync® operation using the Bluetooth™ function (for Bluetooth™ built-in models only)

**Tip**
If you have renamed a target Bluetooth™ compatible device registered on your CLIÉ handheld, the device may be listed in the previous name when you detect target Bluetooth™ compatible devices. In this case, follow the procedure below.

1. Tap the Menu icon on the Bluetooth Preferences screen.
2. Tap Disable device name cache from the Options menu.
3. Detect target Bluetooth™ compatible devices.

7 Select a computer you want to register and tap OK. The Add Trusted Device dialog box is displayed.

8 Tap Yes. The Bluetooth Security dialog box is displayed on your CLIÉ handheld.

9 Enter a passkey and tap OK on your CLIÉ handheld. The Passkey Input dialog box is displayed on the screen of the selected computer.

**Tip**

What is a passkey?
A Passkey is a secret code entered by the user to enable two Bluetooth™ compatible devices to communicate. When the same alphanumeric string is entered at both devices, communication becomes possible. The Passkey may be changed for every communication session as long as the same one is used for both devices. Once a valid link has been established, communication is possible without further Passkey input for a preset period of time.

10 Enter the same passkey you entered in step 9, on your computer. If the name you entered in step 3 is added to the Available Connections: list, the preparation is complete.
Performing the HotSync® operation using the Bluetooth™ function (for Bluetooth™ built-in models only)

**Tips**

- The step in which the **Passkey Input** screen appears varies depending on the mobile phone, and for some devices, the **Passkey input** screen does not appear. In any case, follow the instructions shown on the screen and enter a Passkey when required.
- Depending on the radio wave conditions, it may take time to complete a Bluetooth™ compatible device discovery or establish communication.
- If it takes too long to perform a device discovery, tap **Cancel** on the discovery screen, and conduct a discovery again.
- If the device discovery failed in detecting a device, conduct a discovery again.

**Performing the HotSync® operation using the Bluetooth™ function**

1. Enable the Bluetooth™ function on your computer.

2. Check that the HotSync icon is displayed in the Windows task tray (at the bottom right of the taskbar) on your computer.

   **Tip**

   If the HotSync icon is not displayed in the Windows task tray, click **Start**, select **Programs** (for Windows XP, select **All Programs**), **Sony Handheld**, and click **HotSync Manager** to start the HotSync manager.

3. Rotate the Jog Dial™ navigator to select the HotSync icon on the Application Launcher screen and press the Jog Dial™ navigator.

   The **HotSync** screen is displayed.

   **Tip**

   You can also tap the HotSync icon to display the **HotSync** screen.

4. Check that **Local** is selected.

   * * * * * * * * * * * * * * * * *
Performing the HotSync® operation using the Bluetooth™ function
(for Bluetooth™ built-in models only)

5 Tap the arrow ▼ beneath the icon and select the connection you want to use.
Select the connection name you created in step 3 in “Preparing your CLIÉ handheld” on page 110.

6 Tap the HotSync icon.
The HotSync® operation starts.
A message will be displayed when the HotSync® operation is complete.

Tip
The Bluetooth™ communication between your CLIÉ handheld and computer will be disconnected automatically when the HotSync® operation is complete.
Performing the HotSync® operation via a modem

You can perform the HotSync® operation via a modem when you are away from your computer.

Prior to performing the HotSync® operation via a modem

Check the following items:

- A modem or terminal adapter (TA) is connected to your computer.
- The Palm™ Desktop for CLIÉ software is properly configured for use with the modem.
  ➔ For details, refer to “Customizing HotSync® Manager startup and HotSync® setup options” on page 106.

Notes

- For the first HotSync® operation, you need to perform the local HotSync® operation using the cradle (page 66).
- It may take some time to complete the HotSync® operation via a modem. To shorten the time, define the files/data you wish to synchronize with the modem HotSync® operation in advance. For details, refer to “Selecting the conduits for a modem HotSync® operation” on page 118.
Performing the HotSync® operation via a modem

Preparing your computer
To perform the HotSync® operation via a modem, you need to follow the steps below to set your computer to receive a call from your CLIÉ handheld.

1 Check the following items.
   • The modem is connected to your computer and both the modem and computer are turned on.
   • No communication applications, such as fax or telephone software, are running on the COM port.
   • The computer is disconnected from the Internet.

2 Click the HotSync icon in the Windows task tray (at the bottom right of the taskbar) and select **Modem** from the shortcut menu.

3 Click the HotSync icon in the Windows task tray (at the bottom right of the taskbar) once again and select **Setup** from the shortcut menu. The **Setup** dialog box is displayed.

4 Click the **Modem** tab.
Performing the HotSync® operation via a modem

5 Adjust the following settings as needed.
   - Serial port: Specifies the port for the modem. If you are not sure of the port settings, check the Modem Properties (Phone and Modem Options for Windows 2000 Professional/XP) in the Control Panel.
   - Speed: Determines the speed at which files/data are transferred. Try the As Fast As Possible rate first, and adjust downward if you have any problems.
   - Modem: Specifies the modem type or manufacturer. If you are not sure of your modem type or if you cannot find your modem type in the list, select Hayes Basic.
   - Setup string: Identifies the setup string for your modem automatically if you specify the modem type or manufacturer. If it does not work properly, refer to the manual of your modem.

6 Click OK.

Preparing your CLIÉ handheld
Follow the steps below to set up your CLIÉ handheld for a modem HotSync® operation.

1 Rotate the Jog Dial™ navigator to select the HotSync icon on the Application Launcher screen and press the Jog Dial™ navigator.
   The HotSync screen is displayed.

   Tip
   You can also tap the HotSync icon to display the HotSync screen.

2 Tap Modem.
Performing the HotSync® operation via a modem

3  Tap the **Enter phone #** field beneath the modem name. The **Phone Setup** dialog box is displayed.

![Phone Setup dialog box]

4  Adjust the following settings as needed:

   1. Enter the telephone number used to access the modem connected to your computer.

   2. Enter a dial prefix (such as “9”) to access an outside line, and tap the **Dial prefix** check box as needed. You can also enter a comma in the field to introduce a pause in the dialing sequence. Each comma equals a two second pause.

   3. If the phone line you are using for your CLIÉ handheld has Call Waiting, select the **Disable call waiting** check box to avoid an interruption during the modem HotSync® operation.

   4. If you want to use a calling card to place the call, select the **Use calling card** check box and enter the calling card number.

5  Tap **OK**. The **HotSync** screen is displayed again.
Performing the HotSync® operation via a modem

Selecting the conduits for a modem HotSync® operation
You can specify files/data to be synchronized to shorten the time required to synchronize files/data with a modem.

» For details, refer to “Customizing HotSync® application settings (Conduit)” on page 103.

Note
If your CLIÉ handheld settings do not match those made in the Change HotSync Action window, the operation complies with the CLIÉ handheld’s configurations.

1 Rotate the Jog Dial™ navigator to select the HotSync icon on the Application Launcher screen and press the Jog Dial™ navigator.
The HotSync screen is displayed.

Tip
You can also tap the HotSync icon to display the HotSync screen.

2 Tap the Menu icon.
The menu is displayed.

3 Tap Conduit Setup from the Options menu.
The Conduit Setup screen is displayed.

Continued on next page
Performing the HotSync® operation via a modem

4 Tap the check boxes to deselect the files/data that you do not want to synchronize during a modem HotSync® operation.
   By the default setting, all files/data are selected to be synchronized.
The data of applications that do not have a database (such as games) cannot be synchronized.

5 Tap OK.

Performing the HotSync® operation via a modem
You can perform the modem HotSync® operation when you have prepared your computer settings, CLIÉ handheld settings, and Conduit Setup.

1 Rotate the Jog Dial™ navigator to select the HotSync icon on the Application Launcher screen and press the Jog Dial™ navigator.
The HotSync screen is displayed.

   Tip
You can also tap the HotSync icon to display the HotSync screen.

2 Tap the HotSync icon.
The HotSync® operation starts.
A message will be displayed when the HotSync® operation is complete.
Performing the HotSync® operation via a network

To operate HotSync® operations via a network, you must have network administrator skills.

You can perform the HotSync® operation via a network between your CLIÉ handheld and the computer in the LAN of your office, depending on the network environment of your office. For details, contact the administrator of the remote access server.

**Prior to performing the HotSync® operation via a network**

Check the following items:

- Both your company’s network system and its remote access server support TCP/IP.
- You have a remote access account.

**Preparing your computer**

1. Click the HotSync ☰ icon in the Windows task tray (at the bottom right of the taskbar) and select **Network** from the shortcut menu.

2. Click the HotSync ☰ icon in the Windows task tray (at the bottom right of the taskbar) once again and select **Setup** from the shortcut menu. The **Setup** dialog box is displayed.

3. Click the **Network** tab.

4. Click the check box next to the user name for HotSync. Click **TCP/IP Settings** and assign a subnet mask as needed. For details on a subnet mask address, refer to the manual of your operating system or contact the system administrator.

5. Click **OK**.

*Continued on next page*
Performing the HotSync® operation via a network

6 Place your CLIÉ handheld in the cradle and press the HotSync button.
The computer information (Primary PC name and Primary PC address (IP address)) is transferred to your CLIÉ handheld.
When you perform the HotSync® operation via a network, your CLIÉ handheld identifies the computer based on the information transferred.

Preparing your CLIÉ handheld
Follow the steps below to set up your CLIÉ handheld for the HotSync® operation via a network.

1 Rotate the Jog Dial™ navigator to select the HotSync icon on the Application Launcher screen and press the Jog Dial™ navigator.
The HotSync screen is displayed.

Tip
You can also tap the HotSync icon to display the HotSync screen.

2 Tap Modem.

3 Tap the Menu icon.
The menu is displayed.

4 Tap Modem Sync Prefs from the Options menu.
The Modem Sync Preferences screen is displayed.

Continued on next page
Performing the HotSync® operation via a network

5 Tap Network.

6 Tap OK.
The HotSync screen is displayed.

7 Tap Select Service beneath the icon.
The Network Preferences screen is displayed.

8 Tap the arrow ▼ next to Service and select Unix or Windows RAS from the drop-down list.
   ➪ For details, refer to “Changing the Network preferences” on page 92 and contact the administrator of the remote access server.

9 Tap Done.

10 Tap the Enter phone # field.
The Phone Setup dialog box is displayed.

11 Adjust the settings on the screen as needed.

12 Tap OK.
The HotSync screen is displayed.

13 Follow “Performing the HotSync® operation via a modem” on page 114 to select files/data to be synchronized.
Performing the HotSync® operation via a network

You can perform the HotSync® operation via a network when you have prepared your computer settings, CLIÉ handheld settings, and Conduit Setup.

1. Rotate the Jog Dial™ navigator to select the HotSync icon on the Application Launcher screen and press the Jog Dial™ navigator.
   The HotSync screen is displayed.

   **Tip**
   You can also tap the HotSync icon to display the HotSync screen.

2. Tap the HotSync icon.
   The HotSync® operation starts.
   A message will be displayed when the HotSync® operation is complete.
Performing the HotSync® operation via LAN (LANSync)

To operate LANSync, you must have network manager skills. Consult a network manager prior to setting LANSync.

You can perform the HotSync® operation via LAN between your computer and another computer connected to your CLIÉ handheld.

Prior to performing a LANSync operation
Check the following items:
- The Palm™ Desktop for CLIÉ software is installed in both computers connected by the LAN.
- Your CLIÉ handheld is placed in the cradle connected to the HotSync cable correctly and the cradle is connected to the computer properly.

Preparing your computer

1  Click the HotSync® icon in the Windows task tray (at the bottom right of the taskbar) and select **Network** from the shortcut menu.

2  Click the HotSync® icon in the Windows task tray (at the bottom right of the taskbar) once again and select **Setup** from the shortcut menu.
   The **Setup** dialog box is displayed.

3  Click the **Network** tab.

4  Click the check box next to the user name for HotSync.

5  Click **OK**.

---

Continued on next page
Performing the HotSync® operation via LAN (LANSync)

6 Place your CLIÉ handheld in the cradle and press the HotSync button.
The computer information (Primary PC name and Primary PC address (IP address)) is transferred to your CLIÉ handheld.
When you perform the HotSync® operation via LAN, your CLIÉ handheld identifies the computer based on the information transferred.

Preparing your CLIÉ handheld
Follow the steps below to set up your CLIÉ handheld for the HotSync® operation via the LAN.

1 Rotate the Jog Dial™ navigator to select the HotSync icon on the Application Launcher screen and press the Jog Dial™ navigator.
The HotSync screen is displayed.

Tip
You can also tap the HotSync icon to display the HotSync screen.

2 Tap Local.

3 Tap the Menu icon.
The menu is displayed.

4 Tap LANSync Prefs in the Options menu.
The LANSync Preferences screen is displayed.

5 Tap LANSync.

Continued on next page
Performing the HotSync® operation via LAN (LANSync)

6 Tap OK.
The HotSync screen is displayed again.

Performing a LANSync operation
You can perform a LANSync operation when you have prepared your computer settings, CLIÉ handheld settings, and Conduit Setup. Turn on the computers and start the HotSync® Manager.

Note
To perform a LANSync operation, both computers connected to the cradle and performing the HotSync® are required to be set for LANSync. On each computer, click the HotSync icon in the Windows task tray (at the bottom right of the taskbar) and make sure that Network in the shortcut menu is selected. If not, click Network to select it.

1 Rotate the Jog Dial™ navigator to select the HotSync icon on the Application Launcher screen and press the Jog Dial™ navigator.
The HotSync screen is displayed.

Tip
You can also tap the HotSync icon to display the HotSync screen.

2 Tap the HotSync icon.
The HotSync® operation starts.
A message will be displayed when the HotSync® operation is complete.
Using storage media such as “Memory Stick™” media

This chapter explains how to communicate with another Palm OS® PDA device via storage media such as “Memory Stick” media, how to handle “Memory Stick” media, and how to use CLIE Files for managing the files/data on storage media.

Using storage media such as “Memory Stick™” media ................................. 128
Exchanging files/data via storage media ........................................ 136
Using storage media such as “Memory Stick™” media

The type of storage media you can use with your CLIÉ handheld

You can use your CLIÉ handheld with storage media, such as “Memory Stick” media or CompactFlash compatible memory card (referred to as CF memory card). “Memory Stick” media or CF memory card is specially designed for exchanging and sharing files/data among “Memory Stick” media or CF memory card compatible products. Because it is removable, storage media can also be used for external files/data storage.

Storage media enables you to exchange files/data between your CLIÉ handheld and a computer. To exchange files/data via storage media, your CLIÉ handheld uses the supplied CLIE Files.

Using “Memory Stick” media

There are two types of “Memory Stick” media:
• “MagicGate Memory Stick” media, which is equipped with “MagicGate*” copyright protection technology.
• “Memory Stick” media, which is not equipped with “MagicGate” copyright protection technology.

You can use both types of “Memory Stick” media with your CLIÉ handheld. However, to play music files of ATRAC3 format, make sure that you use “MagicGate Memory Stick” media.

*What is MagicGate?
MagicGate is the copyright protection technology that is used for “MagicGate Memory Stick” media or MagicGate compatible devices such as a CLIÉ handheld. MagicGate certifies the compatible device and “MagicGate Memory Stick” media as copyright-protection-compatible devices and encodes files/data to be played back on devices. Copyrighted files/data cannot be played back on a device not certificated.

“Memory Stick Duo,” “MagicGate Memory Stick Duo,” and “Memory Stick PRO”** can be used with your CLIÉ handheld.

** You can use the “Memory Stick PRO” MSX-1G, MSX-512, and MSX-256 with your CLIÉ handheld.

However, you cannot record or play back files/data that have been copyright protected with the MagicGate function.

▶ For the latest information, refer to the URL shown on the last page of this manual.

Continued on next page
Note on using “MagicGate Memory Stick” media
Do not handle copyright-protected files/data or directories stored on “MagicGate Memory Stick” media with CLIE Files or Windows® Explorer, otherwise the files/data may be disabled. To handle copyright-protected files/data, use a “MagicGate” compliant application such as the SonicStage software.

Notes

If you use a “Memory Stick Duo” with your CLIÉ handheld
• Make sure you use a “Memory Stick Duo” adapter.
• Make sure you insert a “Memory Stick Duo” into the “Memory Stick Duo” adapter in the right direction.
• Make sure you insert a “Memory Stick Duo” into the adapter before you insert the adapter into the “Memory Stick” slot of your CLIÉ handheld.
• Make sure you insert a “Memory Stick Duo” adapter into the “Memory Stick” slot of your CLIÉ handheld in the right direction.

Notes on using “Memory Stick” media
When you use “Memory Stick” media, follow the precautions below.
• Avoid touching the terminals of “Memory Stick” media with your fingers or a metal object.
• Do not drop, bend, or expose “Memory Stick” media to external shock.
• Do not disassemble or modify “Memory Stick” media.
• Avoid getting liquid on “Memory Stick” media.
• Avoid using or storing “Memory Stick” media in a location subject to:
  – extremely high temperature such as inside a hot car, outdoors in direct sunlight, or near a heater
  – direct sunlight – high humidity
  – corrosive substances – excessive dust
  – magnetic fields
• When storing and carrying “Memory Stick” media, keep it in its original case to ensure protection of important files/data.
• Make a backup of important files/data.
• Avoid removing “Memory Stick” media from the insertion slot while files/data is being written or read.
• To avoid damaging or erasing files/data, do not
  – pull out “Memory Stick” media or unplug the AC power adapter while formatting, or reading or writing files/data.
  – use “Memory Stick” media in a location subject to static electricity or electrical interference.
Using storage media such as “Memory Stick™” media

- If the battery power of your CLIÉ handheld is running low, an error message is displayed and you cannot exchange files/data with “Memory Stick” media. If this occurs, connect the AC power adapter or fully charge your CLIÉ handheld.

- Use CLIE Files to format the “Memory Stick” media you use in your CLIÉ handheld. If you format it using another application, further operation with your CLIÉ handheld is not guaranteed.

- If you insert “Memory Stick” media that has been formatted by another application, a message prompting you to reformat it is displayed. To use “Memory Stick” media in your CLIÉ handheld, follow the instructions to format it. Note, however, that all stored files/data will be erased.

- Make sure you stick a suitable label on the “Memory Stick” media.

Protecting the files/data on “Memory Stick” media

To prevent accidental erasure of important files/data, you can use the write protect tab on the “Memory Stick” media.

Write enable position
Slide the tab to the left to select the write enable position. You can read and write files/data on the “Memory Stick” media.

Write protect position (LOCK)
Slide the tab to the right to select the write protect position. You can only read the files/data on the “Memory Stick” media. Select the write protect position when you insert “Memory Stick” media containing any important files/data that you do not want to accidentally delete or overwrite.

Tip
Shape or exact location of the tab may differ from the illustration.
Starting an application on storage media

You can start applications on storage media in the same way as applications on your CLIÉ handheld. While the power of your CLIÉ handheld is on, the applications in the storage media will be displayed on the Application Launcher screen automatically when you insert the storage media into the slot. (The feature does not work when certain applications are running.)

To switch from the Application Launcher screen to the screen where the applications in storage media are displayed, perform the following steps.

**Tip**

These steps only apply to applications saved in the `/Palm/Launcher` folder.

1. Display the Application Launcher screen, while the storage media is inserted in the CLIÉ handheld.

2. Press the BACK button to select the group.

3. Rotate the Jog Dial™ navigator to select Card. 
   The applications stored in the Palm/Launcher folder on storage media are displayed.
   You can start an application in the same way that you start an application of your CLIÉ handheld.
   If you have assigned a name to the storage media, then the Card is displayed in that name.

**Tip**

You can also tap the Card icon to select it.

---

Continued on next page

---
Using storage media such as “Memory Stick™” media

**Note**
Depending on the application, some of the features may not work if you start the application on storage media. In this case, use **CLIE Files** to copy the files/data in the CLIÉ handheld and use the copied files/data.

---

**Viewing information of storage media (Card Info)**

You can view information (such as remaining memory space) of storage media with **Card Info**.

1. Insert the storage media into your CLIÉ handheld.
2. Rotate the Jog Dial™ navigator to select the Card Info icon on the Application Launcher screen and press the Jog Dial™ navigator.
   The **Card Info** screen is displayed.

   **Tip**
   You can also tap the Card Info icon to display the **Card Info** screen.

3. Tap the arrow ▼ next to **Card** to select storage media.
   The information screen of the storage media is displayed.

---

<table>
<thead>
<tr>
<th>Card Info</th>
</tr>
</thead>
<tbody>
<tr>
<td>Card: 8 Card</td>
</tr>
<tr>
<td>Type: Memory Stick</td>
</tr>
<tr>
<td>Size: 17.2 MB Free of 61.8MB</td>
</tr>
</tbody>
</table>

44.5 MB Used
17.2 MB Free of 61.8 MB

MEMORYSTICK (64M)
SONY
Memory Stick
Device ID
Assigning a name to storage media

You can assign a name to each storage media with Card Info.

1 Insert the storage media into your CLIÉ handheld.

2 Rotate the Jog Dial™ navigator to select the Card Info icon on the Application Launcher screen and press the Jog Dial™ navigator.
The Card Info screen is displayed.

3 Tap the arrow ▼ next to Card to select storage media to which you want to assign a name.

4 Tap the Menu ▼ icon.
The menu is displayed.

5 Tap Rename Card in the Card menu.
The Rename Card dialog box is displayed.

6 Enter a new name for the inserted storage media and tap Rename.
Formatting storage media

“Memory Stick” media produced commercially is already formatted for use. CF compatible memory card however, must be formatted with your CLIÉ handheld. If you need to format your storage media, use CLIE Files or Card Info. The following explains how to format storage media with CLIE Files.

1 Insert the storage media into your CLIÉ handheld.

2 Rotate the Jog Dial™ navigator to select the CLIE Files icon on the Application Launcher screen and press the Jog Dial™ navigator. CLIE Files starts.

   **Tip**

You can also tap the CLIE Files icon to start the application.

3 Tap the arrow ▼ at the top right of the CLIE Files screen to select storage media that you want to format.

   **Tip**

You can also tap the icon or the icon to select.

4 Tap the Menu icon. The menu is displayed.

5 Tap Format from the Tool menu.

When multiple storage media are inserted into your CLIÉ handheld, a dialog box is displayed for you to select the storage media you want to format.

6 Enter a new name for the storage media and tap OK. A confirmation message is displayed.

7 Tap OK.

To cancel formatting

Tap Cancel in step 6.

---

Continued on next page
Using storage media such as “Memory Stick™” media

What is formatting?
Formatting defines the recording format for your storage media so that you can access files/data with your CLIÉ handheld.

Notes
- If storage media is reformatted, all the files/data stored on the storage media will be erased. Make sure you check the files/data prior to formatting so that you do not delete important files/data.
- When formatting storage media for use with your CLIÉ handheld, be sure to format it on your CLIÉ handheld. A storage media formatted by any other device may not be read or written properly on your CLIÉ handheld.
- If you remove the storage media during formatting, the storage media will not be usable. In this case, insert the storage media again and restart formatting.
Exchanging files/data via storage media

Starting CLIE Files

You can copy, move, or delete files/data between storage media and your CLIÉ handheld with CLIE Files.

For details on CLIE Files, refer to “CLIE Files” in the “CLIÉ Application Manual” installed on your computer.

1 Rotate the Jog Dial™ navigator to select the CLIE Files icon on the Application Launcher screen and press the Jog Dial™ navigator.

CLIE Files starts.

Tip
You can also tap the CLIE Files icon to start the application.

2 Tap the arrow ▼ at the top right of the CLIE Files screen to select Handheld or storage media.

Tip
You can also tap the icon, the icon, or the icon to select.

When displaying the files/data on storage media

Tap here to sort in ascending or descending order

Tap here to switch the view between your CLIÉ handheld and “Memory Stick” media or CF memory card

Tap here to switch the view of the following:
- size: File size
- date: Updated date
- time: Updated time
- creator: Creator ID of the file
- type: File type
- version: Version of the file
- none: no items displayed

Tap here to switch the view of the following:
- Name: name displayed on the computer
- DBname: name assigned on your CLIÉ handheld

: Tap to display the contents of the zip files*
: Tap to display the contents of the folder*
: Tap to display the upper directory*
Exchanging files/data via storage media

* €, $ and ¶ icons are specific to the screen when displaying the files/data on storage media. Except for these icons, all icons in the screen are common to the one when displaying the files/data on your CLIÉ handheld. You can also rotate the Jog Dial™ navigator to select a folder.

Tip

You can select a folder in the Directory list screen and tap OK to display the contents of the folder. Additionally, you can tap New to create a new folder or tap Rename to change the name of existing folder.

Notes

- You can display up to nine levels of the directory tree.
- The latest change date of the database may not be displayed correctly, depending on how the application was installed.
- When the battery power of your CLIÉ handheld is insufficient, files/data on storage media will not be displayed. In this case, you need to charge your CLIÉ handheld or connect the AC power adapter to your CLIÉ handheld.

When displaying the files/data on your CLIÉ handheld

Tap here to switch the database display by group
- All databases
- Creator group
- Application

Notes on moving or deleting files/data using CLIE Files

In some cases when you move or delete specific files/data using CLIE Files, some CLIÉ handheld applications may not operate properly or some files/data may be formatted. Sony is not liable for any problems with applications or files/data, that arise from your moving or deleting a file/data.

Do not move or delete the following files:
- **Saved Preference:** The final operation status or settings for various applications.

Continued on next page
Using storage media such as "Memory Stick™" media

Exchanging files/data via storage media

- **Unsaved Preference**: The settings for various applications or user information of your CLIÉ handheld. If this file is deleted, you may not be able to synchronize the correct information.

- **CLIE Launcher XXX**: The database for CLIE Launcher. If this file is deleted, you may not be able to operate CLIE Launcher.

- **NetworkDB**: Network settings. If this file is deleted, network connection is disabled.

- **AddressDB**: The database for **Address Book**.*

- **DatebookDB**: The database for **Date Book**.*

- **MemoDB**: The database for **Memo Pad**.*

- **ToDoDB**: The database for **To Do List**.*

* These database files can be copied to storage media as a backup file. If you copy them back to your CLIÉ handheld, the identical files in your CLIÉ handheld will be overwritten with the information at the time of the backup. Note that any added or edited information in your CLIÉ handheld after the backup will not be restored.

**Note**

When the battery power of your CLIÉ handheld is insufficient, files/data on storage media will not be displayed. In this case, you need to charge your CLIÉ handheld or connect the AC power adapter to your CLIÉ handheld.

### Copying your CLIÉ handheld files/data to storage media

You can save your CLIÉ handheld files/data to storage media with **CLIE Files**.

**Notes**

- Since copying files/data consumes a lot of power, you cannot use storage media when your CLIÉ handheld battery power is low. In this case, connect the AC power adapter to your CLIÉ handheld.

- If your CLIÉ handheld receives IR communication while copying files/data, the copying will be interrupted. Do not allow your CLIÉ handheld to receive IR communication while copying files/data.
  - Insert storage media (“Memory Stick” media and/or CF memory card) into your CLIÉ handheld before copying or moving files/data. Never remove storage media while you are copying or moving files/data between your CLIÉ handheld and storage media.
  - Incomplete copying or moving may be leave an invalid file on your CLIÉ handheld or the storage media. In this case, retry copying or moving, and if the confirm overwrite message is displayed, tap **Yes** or **Yes to all**.

1. Insert storage media into your CLIÉ handheld.
Exchanging files/data via storage media

2 Rotate the Jog Dial™ navigator to select the CLIE Files icon on the Application Launcher screen and press the Jog Dial™ navigator. CLIE Files starts.

Tip
You can also tap the CLIE Files icon to start the application.

3 Tap the arrow ▼ at the top right of the CLIE Files screen to select Handheld.
All the Handheld files/data are displayed.

4 Tap the file/data you want to copy to change □ to ✔.
You can select multiple items by selecting the check boxes.

Note
Files/data marked with the icon cannot be copied.

5 Tap Copy.
The Directory list screen is displayed.

6 Tap the storage media directory.
When you want to create a new directory on storage media, tap New and enter the directory name. Tap the directory created.
When you want to rename an existing directory, tap Rename and enter the new name.

7 Tap OK.
The files/data are copied to the directory selected in step 6.

Continued on next page
Exchanging files/data via storage media

To copy all the files/data at once
Tap Select in step 4 and select Select All.

To cancel the selection
• To cancel all the selections: tap Select and select Clear All.
• To clear only specific items: tap the selected item once again.

When you want to select files/data other than the one specified
After following step 4, tap Select and select Invert. The selections of ✔ and ☐ are reversed.

Moving your CLIÉ handheld files/data to storage media
When the available memory in your CLIÉ handheld is insufficient, you can move the files/data from your CLIÉ handheld to storage media.

1 In step 5 above, tap Move.
The selected files/data on your CLIÉ handheld are transferred to the storage media and saved.
Copying files/data on storage media to your CLIÉ handheld

You can copy the files/data saved on storage media to your CLIÉ handheld. Prior to copying files/data, make sure that the memory space of your CLIÉ handheld is sufficient.

**Tip**
You can also copy data to another folder on the storage media.

1. Insert storage media into your CLIÉ handheld.

2. Rotate the Jog Dial™ navigator to select the CLIE Files icon on the Application Launcher screen and press the Jog Dial™ navigator. **CLIE Files** starts.

**Tip**
You can also tap the CLIE Files icon to start the application.

3. Tap the arrow ▼ at the top right of the **CLIE Files** screen to select storage media. All the files/data on the selected storage media are displayed.

4. Tap the file/data you want to copy to change □ to ✔. You can select multiple items by selecting the check boxes.

5. Tap **Copy**. The Directory list screen is displayed.

*Continued on next page*
6  Select **Handheld**.

7  Tap **OK**.

The files/data selected in step 4 are copied to **Handheld**.

**To copy all the files/data at once**

Tap **Select** in step 4 and select **Select All**.

**To cancel the selection**

- **To cancel all the selections**: tap **Select** and select **Clear All**.
- **To clear only specific items**: tap the selected item once again.

**To change the folder to be copied**

Tap [Folder] or [ ] to select the folder you want to copy. The displays of the folders are changed. You can specify a folder to be copied.

**Moving files/data on storage media to your CLIÉ handheld**

You can move the files/data from storage media to your CLIÉ handheld.

1  In step 5 above, tap **Move**.

The selected files/data on the storage media are transferred to your CLIÉ handheld and saved.

**Note**

Some files/data copied from storage media to your CLIÉ handheld may not be synchronized during the HotSync® operation.
Deleting files/data on storage media

You can delete the files/data from storage media with CLIE Files.

1. Insert storage media into your CLIÉ handheld.

2. Rotate the Jog Dial™ navigator to select the CLIE Files icon on the Application Launcher screen and press the Jog Dial™ navigator.
   CLIE Files starts.

   **Tip**
   You can also tap the CLIE Files icon to start the application.

3. Tap the arrow ▼ at the top right of the CLIE Files screen to select storage media.
   All the files/data on the selected storage media are displayed.

4. Tap the file/data you want to delete to change □ to ✓.

5. Tap Del.
   The Delete File dialog box is displayed.

6. Tap OK.
   The files/data selected in step 4 are deleted from storage media.

   **To delete all the data at once**
   Tap Select in step 4 and select Select All.

---

Continued on next page

* * * * * * * * * * * * * * * * * * * * *
Exchanging files/data via storage media

To cancel the selection
• To cancel all the selections: tap Select and select Clear All.
• To clear only specific items: tap the selected item once again.

To change the folder to be deleted
Tap [ 或 ] to select the folder you want to delete. The displays of the folders are changed. You can specify a folder to be deleted.

Extracting a Zip file

You can extract Zip files without using a computer, either downloaded from a website using NetFront v3.0 for CLIE, or received as attachment files with an e-mail on CLIE Mail.

Tip
A Zip file downloaded using NetFront v3.0 for CLIE will be stored in the /Palm/ Programs/Archive folder of storage media inserted into your CLIÉ handheld.

1 Insert storage media containing Zip files into your CLIÉ handheld.

2 Rotate the Jog Dial™ navigator to select the CLIE Files icon on the Application Launcher screen and press the Jog Dial™ navigator.
CLIE Files starts.

Tip
You can also tap the CLIE Files icon to start the application.
Exchanging files/data via storage media

3 Tap the arrow ▼ at the top right of the CLIE Files screen to select storage media.
All the files/data on the selected storage media are displayed.
The icon is Zip files.

Tips
• A Zip file downloaded using NetFront v3.0 for CLIE will be stored in the /Palm/Programs/Archive folder of the storage media.
• An attached file received by CLIE Mail will be stored in the /Palm/Programs/MSFILES folder of the storage media.

4 Tap the Zip file you want to extract.
The contents of the Zip file are displayed on the screen.

5 Tap the file you want to extract to change □ to ✔.
You can select multiple files by selecting the check boxes.

6 Tap Unzip.
The Directory list screen is displayed.

7 Tap a folder in which to save the extracted data.
You can also save the data on your CLIÉ handheld.

Continued on next page
Exchanging files/data via storage media

**Note**
Some data cannot be saved on your CLiÉ handheld. In these cases, an error message is displayed.

8 Tap OK.
The data is extracted to the folder selected in step 7.
- : Files that were extracted normally.
- : Files that could not be extracted.
- : Files that were skipped during extraction.

9 Tap Close.

**To extract all the data at once**
Tap **Select** in step 5 and select **Select All**.

**To cancel the selection**
- To cancel all the selections: tap **Select** and select **Clear All**.
- To clear only specific items: tap the selected item once again.

**To change the folder to be deleted**
Tap  or  to select the folder you want to delete. The displays of the folders are changed. You can specify a folder to be deleted.
The following describes the menu items that are specific to **CLIE Files**. For the menu items common to CLIÉ handheld applications, refer to “Common menu items” on page 39.

### Tool menu

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Format</strong></td>
<td>Formats (initializes) a storage media inserted into your CLIÉ handheld. Note that all data stored on storage media will be erased when formatting the storage media.</td>
</tr>
<tr>
<td><strong>Media Info</strong></td>
<td>Displays information, such as the amount of memory or volume label, of your CLIÉ handheld or storage media.</td>
</tr>
<tr>
<td><strong>New Dir</strong></td>
<td>Creates a folder within the current folder on the storage media. (Only when storage media is selected.)</td>
</tr>
<tr>
<td><strong>Rename</strong></td>
<td>Changes the name of current directory or folder. (Only when storage media is selected.)</td>
</tr>
<tr>
<td><strong>About CLIE Files</strong></td>
<td>Displays the version information of <strong>CLIE Files</strong>.</td>
</tr>
</tbody>
</table>
Exchanging files/data via storage media

You can exchange the files/data between storage media and your CLIÉ handheld or between “Memory Stick” media and CF memory card from the menu of the Application Launcher screen. However, problems may occur depending on the application. Note the following.

- You can copy only applications to storage media. Related files/data cannot be copied.
- Files/data stored on the storage media (such as image files) cannot be displayed.

1. Insert the storage media into your CLIÉ handheld.

2. Tap the Menu icon on the Application Launcher screen. The menu is displayed.

3. Tap Copy from the CLIE Launcher menu. The Copy dialog box is displayed.

4. Tap the arrow next to Copy To, and select Handheld or storage media.

5. Tap the arrow next to From to select storage media or Handheld.

6. Tap the application you want to copy.

7. Tap Copy. The selected application is copied to Handheld or storage media.

Exchanging files/data without using CLIE Files

You can exchange the files/data between storage media and your CLIÉ handheld or between “Memory Stick” media and CF memory card from the menu of the Application Launcher screen. However, problems may occur depending on the application. Note the following.

- You can copy only applications to storage media. Related files/data cannot be copied.
- Files/data stored on the storage media (such as image files) cannot be displayed.
Notes on starting applications from storage media

You can start an application (files with extensions such as .prc,.pdb) from storage media. However, note the following prior to starting them.

- You can start only applications from storage media. Related files/data such as image files or movie files may not be opened (played back).
- When the files/data that cannot be opened in the application are saved on the storage media, move the files/data to your CLIÉ handheld, or delete them by using CLIE Files.

Tip

When the data is installed on storage media with the HotSync® operation, the files/data are stored in the /Palm/Launcher folder.
Beaming

This chapter explains how to communicate with another Palm OS® PDA device via the infrared communications port.

Beaming between your CLIÉ handheld and another Palm OS® PDA . . . . . . . . . . . . . . . . . . . . . 151
Beaming between your CLIÉ handheld and another Palm OS® PDA

What you can do with beaming

Your CLIÉ handheld is equipped with an IR (infrared) port that enables you to exchange data or applications with another Palm OS® PDA device that has an IR port. The IR port is located at the top of your CLIÉ handheld, behind the small dark shield.

You can beam the following information between your CLIÉ handheld and another Palm OS® PDA device that has an IR port:

- The data of Address Book, Date Book, To Do List, or Memo Pad.
- All data in the category currently displayed in Address Book, To Do List, or Memo Pad.
- Address Book data that you designate as your business card.
- Add-on applications installed in the memory.

Note

Some applications are protected from copying and cannot be beamed. Applications marked with the icon cannot be copied.
Beaming between your CLIÉ handheld and another Palm OS® PDA

Beaming information

You can beam the data on your CLIÉ handheld to another Palm OS PDA device that has an IR port.

1 Select the data, category, or business card you want to beam.

2 Tap the Menu icon.
   The menu is displayed.

3 Tap one of the following:
   • The Beam command for an individual record
   • In Address only: Beam Business Card
   • Beam Category

4 When the Beam dialog box is displayed, point the IR port of your CLIÉ handheld directly to the IR port of another Palm OS PDA device.
   The Beam dialog box shows that the transfer is complete.

   (Location of the IR port may vary depending on your model.)

   Tip
   For best performance of the data exchange, keep 4 to 8 inches (approximately 10 to 20 centimeters) between your CLIÉ handheld and the other Palm OS PDA device. Do not place any obstacle between the devices. The optimum distance for beaming may vary depending on devices.
Beaming between your CLIÉ handheld and another Palm OS® PDA

Sending applications via beaming

1 Tap the Menu icon on the Application Launcher screen. The menu is displayed.

2 Tap Beam from the CLIE Launcher menu. The Beam screen is displayed.

3 Tap the arrow next to Beam From and select Handheld. Select Handheld when the application you want to send is saved on your CLIÉ handheld or card when it is saved on the /Palm/Launcher folder on the storage media.

4 Tap an application you want to send, on the Beam screen. Some applications are protected from copying and cannot be beamed. Applications marked with the icon cannot be copied.

5 Tap Beam. A message will be displayed when the beaming is complete.
Receiving beamed information

1 Turn on your CLIÉ handheld and point the IR port of your CLIÉ handheld directly to the IR port of another Palm OS PDA device.
   The Beam dialog box is displayed and beaming of data or applications starts.

2 Select the category where you want to save the received data or applications.
   Data or applications received by beaming are saved in the Unfiled category.
   You can also create a new category to save the data or applications to, or save it in the Unfiled category.

3 Tap Yes.
   The data or applications are saved.

Note
When Beam Receive in the General Preferences screen is set to Off, you cannot receive data or applications using the beaming feature. Prior to beaming data or applications, set Beam Receive to On.
Using the Bluetooth™ function
(for Bluetooth™ built-in models only)

This chapter explains how to exchange information such as applications or data with another Bluetooth™ compatible device using the Bluetooth™ function.

Exchanging files/data using the Bluetooth™ function ........................................ 156
What you can do with the Bluetooth™ function ............................................. 156
Sending files/data, such as image files or Date Book data, to another CLIÉ handheld with the built-in Bluetooth™ function or Bluetooth™ Module (optional) .................. 156
Performing the wireless HotSync® operation with a computer ......................... 158

Connecting to the Internet by communicating with a Bluetooth™ compatible mobile phone . . 159
Exchanging files/data using the Bluetooth™ function

What you can do with the Bluetooth™ function

The Bluetooth™ function enables wireless communication within a range of 33 feet (approximately 10 meters). You can use the function to exchange files/data between your CLIÉ handheld and other Bluetooth™ compliant devices.

Sending files/data, such as image files or Date Book data, to another CLIÉ handheld with the built-in Bluetooth™ function or Bluetooth™ Module (optional)

1. Select a file/data.
   ① Sending an image file, movie file, voice memo, or handwritten memo
   Start CLIE Viewer, tap the Menu icon to display the menu, select Send... from the Data menu, and tap a file/data you want to send.
Exchanging files/data using the Bluetooth™ function

Tip
Sending image files
You can select a method of sending files/data in the Send With dialog box. (The dialog box below may not be displayed depending on your operating environment.)

![Send With dialog box]

Tip
Sending Date Book data or Address Book data
Tap the schedule data or address data you want to send, tap the Menu icon to display the menu, and then select Send Event (for Date Book) or Send Address (for Address Book) from the menu.

2 Send a file/data.
After the Bluetooth Discovery dialog box is displayed, the list of Bluetooth™ compatible CLIÉ handhelds within range of the communication area is displayed on the Discovery Results dialog box. Tap to select the CLIÉ handheld to which you want to send data. The Bluetooth Progress dialog box will be displayed on both CLIÉ handhelds. Follow the on-screen instructions.

Tip
If you have renamed a target Bluetooth™ compatible device registered on your CLIÉ handheld, the device may be listed in the previous name when you detect target Bluetooth™ compatible devices. In this case, follow the procedure below.

1 Tap the Menu icon on the Bluetooth Preferences screen.
2 Tap Disable device name cache from the Options menu.
3 Detect target Bluetooth™ compatible devices.

Note
To view or edit received files/data, applications supporting each file/data must be installed on the CLIÉ handheld.
Performing the wireless HotSync® operation with a computer

If you are using a Bluetooth™ compatible computer, you can perform the wireless HotSync® operation between your CLIÉ handheld and your computer.

For details, refer to “Performing the HotSync® operation using the Bluetooth™ function (for Bluetooth™ built-in models only)” on page 110.
Connecting to the Internet by communicating with a Bluetooth™ compatible mobile phone

You can enjoy browsing various websites or send/receive e-mails using your CLIÉ handheld, via a Bluetooth™ compatible mobile phone.

Connecting
When you access the Internet via a Bluetooth™ compatible mobile phone, you need to follow this procedure to pair the device with your CLIÉ handheld.

1 Setting the connection method/Performing pairing

2 Setting up the network connection

Tip
What is pairing?
To enable Bluetooth™ communication between this Bluetooth™ Module and another Bluetooth™ compatible device, the device must be identified. This process is referred to as pairing which is necessary to prevent access from unauthorized Bluetooth™ compatible devices. A common Passkey is used to pair the device with this Bluetooth™ Module.

1 Setting the connection method/Performing pairing
You need to set the communication method and perform pairing for Bluetooth™ communications.

1 Rotate the Jog Dial™ navigator to select the Prefs icon on the Application Launcher screen and press the Jog Dial™ navigator.
The Preferences screen is displayed.

Tip
You can also tap the Prefs icon to display the Preferences screen.

2 Tap the arrow ▼ at the top right of the screen, and select Connection.
The list of Available Connections appears.

Continued on next page
3 Tap New.

The **Edit Connection** screen appears.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name:</td>
<td>Custom</td>
</tr>
<tr>
<td>Connect to:</td>
<td>Modem</td>
</tr>
<tr>
<td>Via:</td>
<td>Bluetooth</td>
</tr>
<tr>
<td>Device:</td>
<td>Tap to discover</td>
</tr>
<tr>
<td>Dialing:</td>
<td>TouchTone™</td>
</tr>
<tr>
<td>Volume:</td>
<td>Low</td>
</tr>
</tbody>
</table>

1 **Name:** Enter any connection name you like.

*Custom* is displayed by default.

2 **Connect to:** Tap ▼ and select Modem.

3 **Via:** Tap ▼ and select Bluetooth.

4 **Dialing:** Tap ▼ and select the type of telephone circuit you use. The most common selection is TouchTone™.

5 **Volume:** Tap ▼ and select the speaker volume to browse the Internet.

4 Tap **Tap to discover.**

Bluetooth™ compatible device discovery begins in the vicinity of your CLIÉ handheld.

When the discovery is complete, Bluetooth™ compatible devices found around your CLIÉ handheld are displayed.

---

*Continued on next page*
5 Select the mobile phone you want to pair with your CLIÉ handheld, and tap OK.
The Add Trusted Device dialog box appears.

6 Tap Yes.
The Passkey Input screen appears on the display of the mobile phone.

**Tip**

**What is a Passkey?**

A Passkey is a secret code entered by the user to enable two Bluetooth™ compatible devices to communicate. When the same alphanumeric string is entered at both devices, communication becomes possible. The Passkey may be changed for every communication session as long as the same one is used for both devices. Once a valid link has been established, communication is possible without further Passkey input for a preset period of time.

7 Enter a Passkey on the mobile phone, and click OK.
The Authentication screen appears on your CLIÉ handheld.

8 Enter the same Passkey you entered in step 7 and tap OK on your CLIÉ handheld.
Pairing is completed on the CLIÉ handheld and the mobile phone. The communication method you have set is added to the list of Available Connections by the name you entered in Name in step 3.
Using the Bluetooth™ function

Connecting to the Internet by communicating with a Bluetooth™ compatible mobile phone

Tips

- The step in which the **Passkey Input** screen appears varies depending on the mobile phone, and for some devices, the **Passkey input** screen does not appear. In any case, follow the instructions shown on the screen and enter a Passkey when required.
- Depending on the radio wave conditions, it may take time to complete a Bluetooth™ compatible device discovery or establish communication.
- If it takes too long to perform a device discovery, tap **Cancel** on the discovery screen, and conduct a discovery again.
- If the device discovery failed in detecting a device, conduct a discovery again.

Note

Enter a Passkey to activate security. If the security is off and you access the Internet from your CLIÉ handheld through a Bluetooth™ compatible mobile phone, you may be charged the telephone line rental fee that someone else should be paying for.

**2 Setting up the network connection**

You need to set up the network connection in the **Preferences** screen.

1 Tap the arrow ▼ at the top right of the **Preferences** screen to select **Network**.

2 Enter the information about your Internet Service Provider (ISP).

- **Service**
  Select the service (ISP name) to be used.
  If a service you want to use is not listed, select **New** from the menu and add the service name to the list.

- **User Name**
  Enter the user name specified by ISP.

**Continued on next page**
Using the Bluetooth™ function

Connecting to the Internet by communicating with a Bluetooth™ compatible mobile phone

3 Password
Enter the password specified by your ISP.

4 Connection
Select the connection that is compliant with your network card.

5 Phone
Enter the phone number of the access point specified by your ISP.

Tip
For details, contact your ISP or telephone carrier.

Connecting to the Internet

1 Turn on the power of the mobile phone and activate Bluetooth™ communications.
   For detailed operations, refer to the manual of the mobile phone.

2 Start the appropriate application on the Application Launcher screen of your CLIÉ handheld.

3 Start browsing websites, sending or receiving e-mail.
   A dial-up connection is executed.

If you cannot connect to the Internet
   Tap the arrow ▼ at the top right of the Preferences screen, and select Network.
   Tap Connect at the bottom of the screen.
   If you still cannot connect to the Internet, perform pairing again for the Bluetooth™ compatible device (mobile phone), following the instructions in “Connecting” on page 159.
Connecting to the Internet by communicating with a Bluetooth™ compatible mobile phone

After using the Internet

1. Stop the dial-up connection on your CLIÉ handheld.
   - For detailed operations, refer to the “CLIÉ Application Manual” on your computer.

2. Terminate Bluetooth™ communications on the mobile phone.

   **Tip**
   Bluetooth™ communication between the CLIÉ handheld and the mobile phone is automatically cut off when the dial-up connection is disconnected.
Using the Calculator and finding records

This chapter explains how to use the calculator and how to efficiently search for records.

Using the Calculator (Calc) . . . . . . . . . . . . . . 166
Finding records . . . . . . . . . . . . . . . . . . . . . . 169
Calculating with the Calculator

You can perform basic calculations with the Calculator. Moreover, you can save values in the calculator memory and recall them from the memory.

1. Rotate the Jog Dial™ navigator to select the Calculator icon on the Application Launcher screen and press the Jog Dial™ navigator. Calculator starts.

   ![Calculator Interface]

   **Tip**
   You can also tap the Calc icon to start the application.

2. Perform calculations.
   To use the Calculator, tap the numbers or symbols on the screen with the stylus.
The functions of the Calculator buttons

The calculator has several buttons to help you perform calculations.

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CE</strong></td>
<td>Clears the last number you entered. Use this button if you make a mistake while entering numbers. This button enables you to re-enter the number without starting the calculation again.</td>
</tr>
<tr>
<td><strong>C</strong></td>
<td>Clears the entire calculation and enables you to start a new calculation.</td>
</tr>
<tr>
<td><strong>+/-</strong></td>
<td>Toggles the current number between positive and negative. If you want to enter a negative number, enter the number and then tap this button.</td>
</tr>
<tr>
<td><strong>M+</strong></td>
<td>Adds the current number to the total value in the memory. Each number you enter with this button is added to the total value stored in the Calculator memory. The number to be added can be either a calculated value or the number you entered by pressing the number buttons. Pressing this button has no effect on the current calculation (or series of calculations); it merely adds the value to the memory.</td>
</tr>
<tr>
<td><strong>MR</strong></td>
<td>Recalls the total value stored in the Calculator memory and inserts it in the current calculation.</td>
</tr>
<tr>
<td><strong>MC</strong></td>
<td>Clears any value that is stored in the Calculator memory.</td>
</tr>
<tr>
<td><strong>√</strong></td>
<td>Calculates the square root of the entered number. Tap the button after entering the number.</td>
</tr>
</tbody>
</table>
### Using the Calculator menus

#### Edit menus

| Copy, Paste | Copies values from **Calculator** and pastes them into another application. You can also paste numeric values you copied from another application, such as **Memo Pad**, into **Calculator**. |

#### Options menus

<table>
<thead>
<tr>
<th>Recent Calculations</th>
<th>You can review the last series of calculations.</th>
</tr>
</thead>
<tbody>
<tr>
<td>About Calculator</td>
<td>Shows the version information for <strong>Calculator</strong>.</td>
</tr>
</tbody>
</table>
Finding records

Using the Find option

You can find records, such as Date Book, Address Book, To Do List, or Memo Pad data on your CLIÉ handheld, by entering the whole word or the first few letters. The search results are displayed by application. This feature helps if you do not remember which application you used to create the record you are searching for.

**Note**
The Find option is not compatible with some application data.

1 Tap the Find icon.
The Find dialog box is displayed.

2 Enter the text you want to find.
You can enter letters, symbols, or numbers.

3 Tap OK.
The Find option starts to search and displays the list of search results. Comments attached to data can also be searched for.
4 Tap the data you want to view in the list of search results. The application associated with the data automatically starts and opens the data.

**To stop searching**
Tap **Stop** and **Exit**.
To resume the search, tap **Find More**.

**Note**
The **Find** option is not case sensitive; searching for “sony” also finds “Sony.”

**Tip**
If you select text in an application prior to tapping the Find icon, the text is automatically placed in the **Find** dialog box.
Backing up your CLIÉ™ handheld data and applications

This chapter explains how to make a backup of your CLIÉ handheld data.

Backing up your CLIÉ™ handheld data and applications .......................... 172
- Backing up data and applications to your computer with the HotSync® operation........ 172
- Backing up data and applications to “Memory Stick” media using Memory Stick Backup .... 173
You can create a backup of your CLIÉ handheld data by one of the following methods:

- Back up data to your computer through the HotSync® operation
- Back up data to “Memory Stick” media using Memory Stick Backup

### Backing up data and applications to your computer with the HotSync® operation

By the default settings, you can back up the following data to your computer through the HotSync® operation:

- Memo Pad files/data
- Address Book files/data
- To Do List files/data
- Date Book files/data
- Preferences files/data
- Application files/data that have been installed using the HotSync® operation
- User information files to perform the HotSync® operation

When the HotSync® operation is performed, the backup data is compared with the data in your computer, and the newer one becomes effective. If you perform a hard reset, all data stored in your CLIÉ handheld is erased and the initial status will be restored. In this case, you can restore the backup data from your computer that was created through the previous HotSync® operation.

**Notes**

- The following applications or data cannot be backed up with the HotSync® operation.
  - Applications or data beamed or transferred from a “Memory Stick” media or CF memory card
  - Certain applications or driver files added later, or certain data in an application

For details on applications that cannot be backed up, refer to the manual of each application.

When you want to make a complete backup, use Memory Stick Backup.

- If you customize settings in the Change HotSync Action dialog box, you may not be able to create a back up file. You cannot back up an application or restore its data if an option other than “Synchronize the files” is selected.

  ➤ For details, refer to “Customizing HotSync® application settings (Conduit)” on page 103.
Backing up your CLIÉ™ handheld data and applications

Backing up data and applications to “Memory Stick” media using Memory Stick Backup

With Memory Stick Backup, you can back up the following applications and data to “Memory Stick” media.

- Memo Pad files/data
- Address Book files/data
- To Do List files/data
- Date Book files/data
- Preferences files/data
- Add-on application files/data

1. Insert “Memory Stick” media into your CLIÉ handheld.

2. Tap the Home  icon.
The CLIE Launcher screen is displayed.

3. Rotate the Jog Dial™ navigator to select the MS Backup icon on the Application Launcher screen and press the Jog Dial™ navigator.
Memory Stick Backup starts.

4. Tap the Backup  icon.
The Backup All Files dialog box is displayed.

5. Tap OK.
The Backup Progress screen is displayed.
General information of the backup (date, size, and number of database) is displayed in the list.

Note

When backing up data to “Memory Stick” media, free space greater than the size of the data to be backed up, is needed on the “Memory Stick” media. The battery power of your CLIÉ handheld and memory space of “Memory Stick” media should be adequate. Otherwise, data may not be backed up or restored properly.

Continued on next page
Tips

- The backup takes a few minutes.
- In step 4, you can also select an existing file from the backup list then tap the Backup icon to overwrite it.
- The data size displayed in the list shows the size of the applications and data stored in CLIÉ handheld.
- **Number of database** shows the number of applications and data that have been backed up.
- If a backup file on “Memory Stick” media has been updated using **CLIE Files**, the file may not be restored properly.

**To delete a backup file from the “Memory Stick” media**

Select the backup data you want to delete in the Backup list, and tap **Delete**.

**Restoring backup data and applications to your CLIÉ handheld**

**Notes**

- When you restore backup data and applications to your CLIÉ handheld, the data currently saved in your CLIÉ handheld will be overwritten with the backup data. Any data created or edited after you saved the backup will be lost.
- You can only restore data to the CLIÉ handheld from which you took that backup.

1. **Perform a hard reset on your CLIÉ handheld.**
   - For details on a hard reset, refer to “Basic operations of your CLIÉ™ handheld: Restarting your CLIÉ handheld” in the “Read This First (Operating Instructions).”

2. **Insert the “Memory Stick” media containing the backup files into your CLIÉ handheld.**

3. **Tap the Home  icon.**
   - The CLIE Launcher screen is displayed.

4. **Rotate the Jog Dial™ navigator to select the MS Backup icon on the Application Launcher screen and press the Jog Dial™ navigator.**
   - **Memory Stick Backup** starts and the backup list appears.

*Continued on next page*
5 Tap the backup data you want to restore from the list.

6 Tap the Restore icon.
The *Restore All Files* dialog box is displayed.

7 Tap OK.
The *Confirm Restore* dialog box is displayed.

8 Tap OK.
The *Restore Progress* dialog box is displayed.
If there was initial data automatically created by each application when you performed a hard reset or if you created or updated data after a hard reset, the *Restore File* dialog box is displayed. Tap *Yes* to overwrite, tap *Yes To All* to overwrite all data, or tap *No* to leave the data.
When the backup data is restored, the CLIÉ handheld shuts down and restarts automatically.

**Tip**
To restore backed up data by file, use the *Copy* feature in *CLIE Files*.
➢ For details on using *CLIE Files*, refer to “Exchanging files/data via storage media” on page 136.
Protecting your data with a password

This chapter explains how to manage your personal details using the various applications of your CLIÉ handheld and how to protect your data with a password.

Entering personal information .......................... 177

Locking your CLIÉ handheld with a password
(Data protection) ............................................. 179
  Turning off your CLIÉ handheld after locking .................. 179
  Setting your CLIÉ handheld to be locked automatically ........ 181

Protecting data ............................................. 182
  Assigning a password .................................. 182
  Changing or deleting a password ......................... 183
  Hiding or masking private data .......................... 184
Entering personal information

You can enter personal information such as name, company name and telephone number in your CLIÉ handheld. If you assign a password, the personal information will be displayed when the CLIÉ handheld is turned on next time.

1. Rotate the Jog Dial™ navigator to select the Prefs icon on the Application Launcher screen and press the Jog Dial™ navigator. The Preferences screen is displayed.

   Tip

   You can also tap the Prefs icon to display the Preferences screen.

2. Tap the arrow ▼ at the top right of the Preferences screen and select Owner. The Owner preferences screen is displayed.

   Note

   The Bluetooth option is displayed only on Bluetooth™ built-in models.

3. Enter your personal information. When character strings entered do not fit within the screen, a scroll bar is displayed on the right of the screen.
Entering personal information

If you have already assigned a password to protect your data
If personal information is already protected, it cannot be entered or edited. To enter/edit personal information, follow the steps below to unlock the protection.

1. Rotate the Jog Dial™ navigator to select the Prefs icon on the Application Launcher screen and press the Jog Dial™ navigator. The Preferences screen is displayed.

   **Tip**
   You can also tap the Prefs icon to display the Preferences screen.

2. Tap the arrow ▼ at the top right of the Preferences screen and select Owner. The Owner preferences screen is displayed.

3. Tap Unlock. The Unlock Message screen is displayed.

4. Enter the assigned password and tap OK.
Locking your CLIE handheld with a password
(Data protection)

You can lock your CLIE handheld by assigning a password. Your CLIE handheld then requires the user to enter the password when it is turned on.

**Note**

To turn on your CLIE handheld when it is locked, you must enter the correct password. If you forget the password, you need to perform a hard reset. However, performing a hard reset deletes all the data and applications which you installed on your CLIE handheld. (By performing the HotSync® operation, you can restore the backup data or applications from your computer.)

For details on how to reset your CLIE handheld, refer to “Basic operations of your CLIE™ handheld: Restarting your CLIE handheld” of the “Read This First (Operating Instructions).”

Turning off your CLIE handheld after locking

This feature locks and turns off your CLIE handheld. To turn on your CLIE handheld, you must enter the correct password.

1. Perform the HotSync® operation between your computer and CLIE handheld to create backup data from your CLIE handheld to your computer.

For details on the HotSync® feature, refer to “Backing up data and applications to your computer with the HotSync® operation” on page 172.
2 Rotate the Jog Dial™ navigator to select the Security icon on the Application Launcher screen and press the Jog Dial™ navigator. The Security screen is displayed.

![Security screen](image)

Tip
You can also tap the Security icon to display the Security screen.

3 Follow “Assigning a password” on page 182 to assign a password.

4 Tap Lock & Turn Off.
The System Lockout screen is displayed.

![System Lockout screen](image)

5 Tap Off & Lock.
Your CLIÉ handheld turns off and locks.
To turn on your CLIÉ handheld, you must enter the correct password.

Note
The Graffiti® writing system will be displayed in System Lockout mode, even if you were using the Decuma Input system.
You can drag the stylus from left to right on the status bar to switch the Silk screen area.
Setting your CLIÉ handheld to be locked automatically

You can set a time for your CLIÉ handheld to be locked automatically.

1. Follow steps 1 to 3 of “Turning off your CLIÉ handheld after locking” on page 179.

2. Tap **Never**.
   The **Password** screen is displayed.

3. Enter the password and tap **OK**.
   The **Lock Handheld** screen is displayed.

4. Tap your choice from the list on the **Lock Handheld** screen.
   - **Never**: Your CLIÉ handheld is not locked automatically.
   - **On power off**: Your CLIÉ handheld is locked when it is turned off.
   - **At a preset time**: Sets a time for your CLIÉ handheld to be locked automatically.
   - **After a preset delay**: Sets a time for your CLIÉ handheld to be locked automatically if it is inactive for a preset time interval.

5. Tap **OK**.
You can protect your data from unauthorized users by assigning a password. Additionally, you can create private data which will not be shown even if a password is entered.

Assigning a password

You can assign a password to protect your private data or to lock your CLIÉ handheld.

1 Rotate the Jog Dial™ navigator to select the Security icon on the Application Launcher screen and press the Jog Dial™ navigator. The Security screen is displayed.

Tip

You can also tap the Security icon to display the Security screen.

2 Tap -Unassigned-. The Password dialog box is displayed.

3 Enter a password. Enter up to 29 alphanumeric characters (in the range a-z, 0-9).

4 Tap OK. The Password dialog box is displayed.

5 Enter the password once again to verify it and tap OK. Your password is assigned and -Assigned- is displayed on the screen in step 2.
Protecting data

Tip
In step 3, you can enter a hint to remember your password. The hint will be displayed to remind you of the correct password if you enter an incorrect password.

Changing or deleting a password

You can change or delete the assigned password.

1 Rotate the Jog Dial™ navigator to select the Security icon on the Application Launcher screen and press the Jog Dial™ navigator.
   The Security screen is displayed.

   Tip
   You can also tap the Security icon to display the Security screen.

2 Tap -Assigned-.
   The Password dialog box is displayed.

3 Enter the current password and tap OK.
   The Password dialog box is displayed.

4 Enter a new password and tap OK.
   To delete the password, tap Unassign.

If you forget your password
If you forget your password, you can delete it forcibly. However, note that deleting the password forcibly also deletes all your private data. (If you perform the HotSync® operation to synchronize with your computer, you can restore your private data that has been backed up.)

1 In the above step 2, tap Lost Password.
   The Delete Password dialog box is displayed.

2 Tap Yes.
   Your password and private data are deleted.
Hiding or masking private data

You can choose to hide or mask your private data in applications such as Address Book or Memo Pad. To view the private data, you need to enter the password. Even if the data is invisible, it is saved.

1 Rotate the Jog Dial™ navigator to select the Security icon on the Application Launcher screen and press the Jog Dial™ navigator.

The Security screen is displayed.

Tip
You can also tap the Security icon to display the Security screen.

2 Tap the arrow ▼ next to Current Privacy to select Mask Records or Hide Records.

The Mask Records screen or Hide Records screen is displayed.

3 Tap OK.

The private data becomes invisible.

When you select Hide Records

When you select Mask Records
Enhancing features with add-on applications

This chapter explains how to enhance features of your CLIÉ handheld by installing applications from your computer, Internet and storage media such as “Memory Stick” media.

Enhancing features with add-on applications .......................... 186

Installing ................................................................. 187
  Installing from your computer ................................. 187
  Installing applications on storage media ......... 189
  Installing from the Internet ............................... 189
  Deleting installed add-on applications ............ 190
You can enhance the features of your CLIÉ handheld by installing applications such as games or other application that run on Palm OS (Add-on applications). For the latest information on the applications that can be used in your CLIÉ handheld, refer to your CLIÉ handheld support website. For details of the website, refer to the URL shown on the last page of this manual.

**Note**

As all the add-on applications installed on your CLIÉ handheld are temporarily saved in the memory, all the add-on applications will be deleted when a hard reset is performed. In this case, you would need to reinstall them on your CLIÉ handheld.
Installing from your computer

You can install the applications of your computer into your CLIÉ handheld.

For details on how to install the applications that are supplied with your CLIÉ handheld, refer to “Using applications” of the “Read This First (Operating Instructions).”

1 Double click the Palm™ Desktop for CLIÉ icon on the Windows desktop.
   You can also click Start, select Programs (for Windows XP, select All Programs), Sony Handheld, and click Palm Desktop for CLIÉ.
   The Palm™ Desktop for CLIÉ software starts.

2 Click Install.
   The Install Tool screen is displayed.

3 Select the user from the User list.

4 Click Add.
   The Open dialog box is displayed.
   The supplied applications are saved in the folder: Program Files/ Sony Handheld/Add-on.

Continued on next page
5 Select applications you want to install from the folder and click **Open**.

A list of the selected applications is displayed on the Install Tool screen. Click **Remove** to delete applications that you do not want to install. The applications will be deleted from the list, but not from your computer.

6 Click **Done**.

The confirmation screen is displayed.

7 Click **OK**.

8 Perform the local HotSync® operation.

The applications selected in step 5 are installed into your CLIÉ handheld.

⇒ For details on local HotSync®, refer to “Performing the HotSync® operation” on page 66.

Displaying the Install Tool screen directly from the Start menu in Windows

To display the Install Tool screen, click **Start**, select **Programs** (for Windows XP, select **All Programs**), **Sony Handheld**, and click **Installation Tool**. You can also double-click files that can be installed, such as .prc or .pdb format files.
Installing applications on storage media

Applications can be installed on storage media such as “Memory Stick” media or CF memory card by the following methods:

• Install an application directly into “Memory Stick” media from your computer using Data Import/Data Export.
• After step 5 of “Installing from your computer,” click Change Destination. Select the application and click either >> or << to specify Memory Stick or CompactFlash Card for the location to save the application.

Notes on installing applications on storage media:
In some applications, related files such as image files or movie files cannot be opened (played back).
In the procedure mentioned above, select Memory Stick or CompactFlash Card and install the data or application onto the storage media you select by the HotSync® operation. They are installed in /Palm/Launcher folder. Some Sony applications only support data in the designated folder. The data installed in /Palm/Launcher folder on storage media by the HotSync® operation cannot be displayed in those applications.
In this case, delete the data or applications from the storage media using CLIE Files.

Installing from the Internet

You can download applications from the CLIÉ handheld support website and install them on your CLIÉ handheld.
For details of the website, refer to the URL shown on the last page of this manual.

1. Download the applications you want to install in your computer, from the Internet.
Installing

2 Follow the instructions including readme files to install the downloaded application in your CLIÉ handheld.
If there are no specific instructions, double-click the downloaded PRC format (.prc) file and perform step 6 through 8 of “Installing from your computer” on page 187.

Deleting installed add-on applications

Tip
You can only delete the applications that you installed yourself. Default applications, such as Address Book and Memo Pad, cannot be deleted.

1 Tap the Home icon.
The CLIE Launcher screen is displayed.

2 Tap the Delete icon.
The Delete dialog box is displayed.

Tip
When the Use Drag&Drop check box on the CLIE Launcher Preferences screen (page 27) is on, you can also delete an application by dragging its icon and dropping it in the Delete icon at the top right of the screen.

3 Tap the arrow ▼ next to delete source to select Handheld or storage media.

4 Tap the application you want to delete and tap Delete.
A confirmation message appears.

5 Tap Yes.
The application selected in step 4 is deleted.
To cancel deleting, tap No.

Continued on next page
6 Tap **Done**.
The Application Launcher screen is displayed.
Transferring data from another CLIÉ™ handheld

This chapter explains how to transfer data from your CLIÉ handheld to another CLIÉ handhelds.

Transferring data from another CLIÉ™ handheld ........................................... 193
Transferring data using the Palm™ Desktop for CLIÉ software ......................... 193
Transferring data from another CLIÉ™ handheld

Notes

- You cannot transfer data from another CLIÉ handheld with Memory Stick Backup.
- You cannot transfer applications that you installed. You need to reinstall them to your CLIÉ handheld.
- Some third party applications may operate only on your old CLIÉ handheld. For details, contact the application manufacturer.

Transferring data using the Palm™ Desktop for CLIÉ software

For data of the basic Palm OS® applications such as Address Book, Memo Pad, To Do List, and Date Book, you can use the Palm™ Desktop for CLIÉ software to transfer data from your old CLIÉ handheld to your new CLIÉ handheld, by exporting and importing data. Before you start transferring data, you need to perform the HotSync® operation between your old CLIÉ handheld and the Palm™ Desktop for CLIÉ software. Your new CLIÉ handheld will need a new user name. Perform the HotSync® operation following “Exchanging and updating files/data using the HotSync® operation” on page 63. Then follow the steps below.

1. Double-click the Palm™ Desktop for CLIÉ icon on your Windows desktop. You can also click Start, select Programs (for Windows XP, select All Programs), Sony Handheld, and click Palm Desktop for CLIÉ. The Palm™ Desktop for CLIÉ software starts.

2. Select the user name of your previous CLIÉ handheld from the list at the top right of the screen.

3. Click the icon of the application you want to copy.

4. Click Export, from the File menu.

5. Enter the file name and click Export. The data of your old CLIÉ handheld is exported. Change the location to save the application as needed.

Continued on next page
6 Repeat step 3 through 5 to export data of other applications.

7 Select the user name of your new CLIÉ handheld from the list at the top right of the screen.

**Tip**
If you have never performed the HotSync® operation with your new CLIÉ handheld, select **Users** from the **Tools** menu. Click **New** in the **Users** screen and enter the new user name. Then select the user name you just entered.

8 Click **Import**, from the **File** menu.

9 Select the files you have exported in step 3 through 6 and click **Open**.

10 Perform the HotSync® operation.
    The data exported from your old CLIÉ handheld is copied onto your new CLIÉ handheld.

**Do not perform the HotSync® operation with the same user name of other CLIÉ handhelds**
If you perform a HotSync® operation between your new CLIÉ handheld and the Palm™ Desktop for CLIÉ software for your old CLIÉ handheld, and use the old user name, then setup information specific to the old CLIÉ handheld will be transferred with data. This may causes some problems. Similarly, if you try performing the HotSync® operation with your old CLIÉ handheld, problems may also arise. Do not transfer data by this method.

**The screen to select the user name is displayed when performing the HotSync® operation in your CLIÉ handheld**
Please enter a name that is different from the user name of the CLIÉ handheld being used. If the same user name is used, the Palm™ Desktop for CLIÉ software will not recognize your CLIÉ handheld properly and the data of the respective models will be mixed or deleted. Moreover, if you copy **UnsavedPreference** from another CLIÉ handheld to your CLIÉ handheld, you will not be able to manage your CLIÉ handheld with another name, since the user name is also copied.
Note on performing the HotSync® operation on another CLIÉ™ handheld

When using a new CLIÉ™ handheld, install (overwrite) the Palm™ Desktop for CLIÉ software supplied with the newly purchased CLIÉ™ handheld. Install this without deleting the old Palm™ Desktop for CLIÉ software being used, from your computer.

The new Palm™ Desktop for CLIÉ™ software will replace the old software, except for the necessary features required by the old CLIÉ™ handheld.
INDEX

A

Application

Add-on applications .................. 186
Deleting the add-on applications . 190
Enhancing the features ............... 186
Installing applications on storage media .................. 189
Installing from the Internet ......... 189
Installing from your computer ...... 187
Quitting ................................ 15
Starting ............................ 14

Application buttons .................. 78

Application Launcher screen

CLIE Launcher ....................... 14
Palm OS standard screen .......... 28

Application manager icon

Beam ............................... 24
Delete ............................. 24
Info ................................ 24

Archive ............................... 65, 105

Automatic power-off time .......... 88

B

Backing up data

Backing up data and applications to “Memory Stick” media using Memory Stick Backup ............... 173
Backing up data and applications to your computer with the HotSync® operation .................. 172

Basic operations ..................... 10

Beam Receive feature

Beaming ............................. 152
IR HotSync .......................... 107
Receiving ............................. 154
What you can do ....................... 151

Bluetooth™ function

Communicating with a Bluetooth™ compatible mobile phone .............. 159
Exchanging files/data .................. 156
HotSync® operation using the Bluetooth™ function .......................... 110
Performing the wireless HotSync® operation with a computer ............ 158
Setting ............................... 75
Turning on or off ....................... 75
What you can do ....................... 156

Brightness ............................ 79

Buttons ............................... 78, 79, 80

C

Calculator

Calculating ......................... 166
functions of the Calculator buttons .................. 167
Using the Calculator menus ................. 168

CF compatible memory card .......... 14, 128

CLIE Files

Copying files/data on storage media to your CLIÉ handheld ............... 141
Copying your CLIÉ handheld files/data to storage media .................. 138
Deleting files/data on storage media .......................... 143
Exchanging files/data without using CLIE Files ......................... 148
Menu items ........................... 147
Starting ............................ 136

CLIÉ Launcher

Application manager icon ............ 24
CLIÉ Launcher group .................. 18
Creating a new group ............... 20
Deleting a group ..................... 21

Continued on next page

196
<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Displaying information about applications</td>
</tr>
<tr>
<td>Locating the components</td>
</tr>
<tr>
<td>Menu List</td>
</tr>
<tr>
<td>Ordering listed groups</td>
</tr>
<tr>
<td>Selecting a group</td>
</tr>
<tr>
<td>Using Favorite Applications (shortcuts)</td>
</tr>
<tr>
<td>Common menu items</td>
</tr>
<tr>
<td>Communication device</td>
</tr>
<tr>
<td>Conduit</td>
</tr>
<tr>
<td>Connection</td>
</tr>
<tr>
<td>Customizing the full-screen pen stroke activities</td>
</tr>
<tr>
<td>Graffiti® writing</td>
</tr>
<tr>
<td>Graffiti character list</td>
</tr>
<tr>
<td>Graffiti writing area</td>
</tr>
<tr>
<td>Using Navigation strokes and shortcuts</td>
</tr>
<tr>
<td>What is Graffiti writing?</td>
</tr>
<tr>
<td>Hide Records</td>
</tr>
<tr>
<td>HotSync</td>
</tr>
<tr>
<td>Assigning applications to HotSync buttons</td>
</tr>
<tr>
<td>Customizing HotSync® application settings (Conduit)</td>
</tr>
<tr>
<td>Customizing HotSync® Manager startup and HotSync® setup options</td>
</tr>
<tr>
<td>Performing the HotSync® operation</td>
</tr>
<tr>
<td>Performing the HotSync® operation using the Bluetooth™ function</td>
</tr>
<tr>
<td>Performing the HotSync® operation via a modem</td>
</tr>
<tr>
<td>Performing the HotSync® operation via a network</td>
</tr>
<tr>
<td>Performing the HotSync® operation via LAN (LANSync)</td>
</tr>
<tr>
<td>Performing the HotSync® operation with the cradle (Local HotSync®)</td>
</tr>
<tr>
<td>Performing the IR HotSync® operation</td>
</tr>
<tr>
<td>Synchronizing with external data (File Link)</td>
</tr>
<tr>
<td>What is the HotSync® operation?</td>
</tr>
<tr>
<td>IR port</td>
</tr>
</tbody>
</table>

Continued on next page
<table>
<thead>
<tr>
<th>Section</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>User name</td>
<td>103, 120</td>
</tr>
<tr>
<td>Using Favorite Applications (shortcuts)</td>
<td></td>
</tr>
<tr>
<td>Creating</td>
<td>22</td>
</tr>
<tr>
<td>Deleting</td>
<td>24</td>
</tr>
<tr>
<td>Using the Palm OS® standard screen</td>
<td></td>
</tr>
<tr>
<td>Changing the display style of the Palm OS® standard screen</td>
<td>34</td>
</tr>
<tr>
<td>Starting an application</td>
<td>30</td>
</tr>
<tr>
<td>Switching to the CLIE Launcher screen</td>
<td>29</td>
</tr>
<tr>
<td>View Log</td>
<td>100</td>
</tr>
</tbody>
</table>
For the latest information on support and accessories, check our official Sony CLIÉ website

For customers in the U.S.A. and Canada
http://www.sony.com/clie/

For customers in Australia, Hong Kong, Malaysia, Mexico, New Zealand, Singapore, Taiwan and Thailand
http://vaio-online.sony.com/clie/